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Safety

The caution and danger statements that this document contains can be referenced
in the multilingual IBM® Safety Information document that is provided with every
IBM TotalStorage® DS4000 Storage Subsystem. Each caution and danger
statement is numbered for easy reference to the corresponding statements in the
translated document.

» Danger: These statements indicate situations that can be potentially lethal or
extremely hazardous to you. A danger statement is placed just before the
description of a potentially lethal or extremely hazardous procedure, step, or
situation.

» Caution: These statements indicate situations that can be potentially hazardous
to you. A caution statement is placed just before the description of a potentially
hazardous procedure step or situation.

» Attention: These notices indicate possible damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage could occur.

Before installing this product, read the following danger and caution naotices.

© Copyright IBM Corp. 2005 i



Statement 1:

A A

DANGER

Electrical current from power, telephone, and communication cables is
hazardous.

To avoid a shock hazard:

* Do not connect or disconnect any cables or perform installation,
maintenance, or reconfiguration of this product during an electrical
storm.

* Connect all power cords to a properly wired and grounded electrical
outlet.

* Connect to properly wired outlets any equipment that will be attached to
this product.

* When possible, use one hand only to connect or disconnect signal
cables.

* Never turn on any equipment when there is evidence of fire, water, or
structural damage.

» Disconnect the attached power cords, telecommunications systems,
networks, and modems before you open the device covers, unless
instructed otherwise in the installation and configuration procedures.

» Connect and disconnect cables as described in the following table when
installing, moving, or opening covers on this product or attached
devices.

To Connect: To Disconnect:

Turn everything OFF.

First, attach all cables to devices.
Attach signal cables to connectors.
Attach power cords to outlet.

Turn everything OFF.
First, remove power cords from outlet.
Remove signal cables from connectors.

P w iR

Remove all cables from devices.

ok wde

Turn device ON.
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Statement 3:

A

CAUTION:
When laser products (such as CD-ROMs, DVD drives, fiber optic devices, or
transmitters) are installed, note the following:

* Do not remove the covers. Removing the covers of the laser product could
result in exposure to hazardous laser radiation. There are no serviceable
parts inside the device.

» Use of controls or adjustments or performance of procedures other than
those specified herein might result in hazardous radiation exposure.

A

DANGER

Some laser products contain an embedded Class 3A or Class 3B laser
diode. Note the following.

Laser radiation when open. Do not stare into the beam, do not view directly
with optical instruments, and avoid direct exposure to the beam.

Class 1 Laser statement

Cless 1 Laser Product
Lager Klasse 1

Lasar Klass 1

Luiesmn 1 _Lasaﬂaha

Apparall A Laser de Classs 1

IEC 825-11993 CENELEC EN 60 825

Safety V
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Statement 4:

A

> 18 kg (39.7 Ib) > 32 kg (70.5 Ib)

= 55 kg (121.2 Ib)

CAUTION:
Use safe practices when lifting.

Statement 5:

A A

CAUTION:

The power control button on the device and the power switch on the power
supply do not turn off the electrical current supplied to the device. The device
also might have more than one power cord. To remove all electrical current
from the device, ensure that all power cords are disconnected from the power

source.

VAN

2 (1) mp —m_—
1 [{) mp =—
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Statement 8:

A A

CAUTION:
Never remove the cover on a power supply or any part that has the following
label attached.

& A\

Hazardous voltage, current, and energy levels are present inside any
component that has this label attached. There are no serviceable parts inside
these components. If you suspect a problem with one of these parts, contact
a service technician.

Safety Vil
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About this document

This document describes procedures for adding new Fibre Channel or SATA hard
drives or new IBM TotalStorage DS4000 drive expansion enclosures containing new
Fibre Channel or SATA hard drives to an existing IBM DS4000 Storage Subsystem
configuration. This document also describes the procedure for migrating either Fibre
Channel hard drives or IBM TotalStorage DS4000 storage expansion enclosures
containing Fibre Channel hard drives from one DS4000 storage subsystem to

another.

FAStT product

renaming

IBM has renamed some FAStT family products. identifies each DS4000
product name with its corresponding previous FAStT product name. Note that this
change of product name only indicates no change in functionality or warranty. All

products listed below with new names are functionally-equivalent and
fully-interoperable. Each DS4000 product retains full IBM service as outlined in
service contracts issued for analogous FAStT products.

Table 1. Mapping of FAStT names to DS4000 Series names

Previous FAStT Product Name

Current DS4000 Product Name

IBM TotalStorage FAStT Storage Server

IBM TotalStorage DS4000

FAStT

DS4000

FAStT Family

DS4000 Mid-range Disk System

FASLT Storage Manager vX.Y (for example

DS4000 Storage Manager vX.Y (for example

v9.10) v9.10)

FAStT100 DS4100
FAStT600 DS4300
FAStT600 with Turbo Feature DS4300 Turbo
FAStT700 DS4400
FAStT900 DS4500
EXP700 DS4000 EXP700
EXP710 DS4000 EXP710
EXP100 DS4000 EXP100

FAStT FlashCopy

FlashCopy for DS4000

FAStT VolumeCopy

VolumeCopy for DS4000

FAStT Remote Mirror (RM)

Enhanced Remote Mirroring for DS4000

FAStT Synchronous Mirroring

Metro Mirroring for DS4000

Global Copy for DS4000
(New Feature = Asynchronous Mirroring
without Consistency Group)

Global Mirroring for DS4000
(New Feature = Asynchronous Mirroring with
Consistency Group)

© Copyright IBM Corp. 2005
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Who should read this document

This document is intended for system administrators who are familiar with the IBM
TotalStorage DS4000 storage subsystem components, terminology, and DS4000
Storage Subsystem administrative tasks.

llustrations

lllustrations contained in this document depict general visual characteristics of the
DS4000 Storage Subsystem, storage expansion unit, and fibre channel drive
hardware cited. They are not intended for use as detailed DS4000 storage
hardware images.

Using this document

Before you proceed to complete any storage addition or migration procedures
detailed in this publication, familiarize yourself with the principles, prerequisite
instructions at[Chapter 2, “Prerequisites to adding capacity and hard drive]
[migration,” on page 35]as well as the following storage addition or migration
procedures applicable to your specific needs.

+ [Chapter 3, “Adding one or more new hard drives,” on page 45|

+ |Chapter 4, “Migrating one or more hard drives,” on page 51|

+ |Chapter 5, “Adding expansion units containing new hard drives,” on page 59|
+ [Chapter 6, “Migrating expansion units containing hard drives,” on page 77|

+ |Chapter 7, “Upgrading a storage subsystem in a functioning configuration,” on|

page 93|

Your familiarity with the principles, preliminary procedures, and detailed steps
described in this document is critical to prevent loss of data availability, and in some
cases, loss of data. If you have questions about the procedures described in this
document, please contact the IBM Help Center in your geography for assistance.

Important:

1. Do not mix SATA and Fibre Channel drives in the same enclosure.

2. Do not place SATA drives in a fibre channel enclosure (DS4300 or EXP710).
3. Do not place fibre channel drives in a SATA enclosure (DS4100 or EXP100).
4

Do not mix SATA drive expansion enclosures (EXP100) and Fibre channel drive
enclosures (EXP700, EXP710 and EXP500) in the same drive loop or the same
DS4000 Storage Subsystem unless you purchase the fibre channel/SATA
intermix premium feature entitlement and upgrade the controller firmware to
06.10.11.xx or higher.

DS4000 installation process overview

The following flow chart gives an overview of the DS4000 hardware and the
DS4000 Storage Manager software installation process. Lined arrows in the flow
chart indicate consecutive steps in the hardware and software installation process.
Labeled arrows indicate which current documents provide detailed information about
those steps.
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Install Process Documentation

N : * FC Planning and — DS4000 Storage Server
Plan installation Integrati%n:SUs?r'fs Guide > Connect Power and Installation Guide
and Svc Info
Start Server D_S4000 Hardware
DS4000 Storage Manager Maintenance Manual
Install Storage Concepts Guide 4 DS4000 Problem
Server/RAID Controller Verify Server Determination Guide
Enclosure(s) in Rack DS4000 Storage Svr operation w/ LEDs
Installation Guide
DS4000 RAID Controller
A 4 Enclosure Unit Install 4
and User's Guide DS4000 St
Install Storage Preparg for Manager Inst%rlfa?tﬁ)n
Expansion Enclosure(s) Installation of and Support
DS4000 Storage Exp Encls SM Software 0S Guides
Install and User's Guides
C Connecti =
Make F onnections Install and Verify DS4000 Storage Manager
. 2 SM SW on Host and Copy Services
SET Link Speed DS4000 and HBA Install Workstation Leesclice
(1GB or 2GB) and User's Guides
DS4000 Fibre Channel v
- Storage Server Complete SM SW
Determine Installation Guides Installation
Management
Outof.Band Method Fibre Channel Cabling
ut-of-Ban i
Instructions Configure Storage Online Help
Install Network Hardware
Hardware; Prep are
Network Connection
> Configure Storage g
Subsystems on Host S
o

Figure 1. Installation process flow by current publications

DS4000 Storage Subsystem publications

The following tables present an overview of the DS4500, DS4400, DS4300,
DS4100, and DS4800 Storage Subsystem product libraries, as well as other related
documents. Each table lists documents that are included in the libraries and what
common tasks they address.

You can access the documents listed in these tables at one of the following Web
sites:

www.ibm.com/servers/storage/support/diski|

www.ibm.com/shop/publications/order|

DS4500 Storage Server library

[Table 2 on page xx| associates each document in the DS4500 (previously
FAStT900) Storage Server library with its related common user tasks.

About this document ~ XiX


http://www.ibm.com/servers/storage/support/disk/
http://www.ibm.com/shop/publications/order/

Table 2. TotalStorage DS4500 Fibre Channel Storage Server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStorage
DS4500 Installation
and Support Guide,
GC26-7727

IBM TotalStorage
DS4500 Fibre
Channel Cabling
Instructions,
GC26-7729

IBM TotalStorage
DS4500 Storage
Server User’s
Guide, GC26-7726

IBM TotalStorage
DS4500 Rack
Mounting
Instructions,
GC26-7728
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DS4400 Storage Server library
associates each document in the DS4400 (previously FAStT700) Storage

Table 3. TotalStorage DS4400 Fibre Channel Storage Server document titles by user tasks

Server library with its related common user tasks.

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM DS4400 Fibre
Channel Storage
Server User's
Guide, GC26-7730

IBM DS4400 Fibre
Channel Storage
Server Installation
and Support Guide,
GC26-7731

IBM DS4400 Fibre
Channel Cabling
Instructions,
GC26-7732

About this document
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DS4300 Storage Server library

associates each document in the DS4300 (previously FAStT600) Storage
Server library with its related common user tasks.

Table 4. TotalStorage DS4300 Fibre Channel Storage Server document titles by user tasks

Title User Tasks

Planning |Hardware Software Configuration |Operation and |Diagnosis and
Installation Installation Administration |Maintenance

IBM TotalStorage
DS4300 Fibre
Channel Storage
Server Installation
and User’'s Guide,
GC26-7722

IBM TotalStorage
DS4300 Rack

Mounting I I
Instructions,
GC26-7724

IBM TotalStorage
DS4300 Fibre

Channel Cabling I v
Instructions,
GC26-7725

IBM TotalStorage
DS4300 SCU Base
Upgrade Kit,
GC26-7740

IBM TotalStorage
DS4300 SCU Turbo
Upgrade Kit,
GC26-7741

IBM TotalStorage
DS4300 Turbo

Models 6LU/6LX I I
Upgrade Kit,
GC26-7723
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DS4100 Storage Server library

Table 5. TotalStorage DS4100 SATA Storage Server document titles by user tasks

associates each document in the DS4100 (previously FAStT100) Storage
Server library with its related common user tasks.

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStorage
DS4100 Installation,
User’'s and
Maintenance Guide,
GC26-7733

IBM TotalStorage
DS4100 Fibre
Channel Cabling
Instructions,
24P8973

About this document
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DS4800 Storage Subsystem library

associates each document in the DS4800 Storage Subsystem library with
its related common user tasks.

Table 6. TotalStorage DS4800 Storage Subsystem document titles by user tasks

Title User Tasks
Planning |Hardware Software Configuration |Operation and |Diagnosis and
Installation Installation Administration |Maintenance
IBM TotalStorage
DS4800 Installation,
User’'s and [ e 1/ 1/ I
Maintenance Guide,
GC26-7748
IBM TotalStorage
DS4800 Installation o

and Cabling
Overview, 22R4738
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DS4000 Storage Manager Version 9 publications

associates each document in the DS4000 Storage Manager (previously

FAStIT Storage Manager) library with its related common user tasks.

Table 7. TotalStorage DS4000 Storage Manager Version 9 titles by user tasks

Title

User tasks

Planning

Hardware
installation

Software
installation

Configuration

Operation and
administration

Diagnosis and
maintenance

IBM TotalStorage
DS4000 Storage
Manager Version 9
Installation and
Support Guide for
Windows
2000/Server 2003,
NetWare, ESX
Server, and Linux,
GC26-7706

IBM TotalStorage
DS4000 Storage
Manager Version 9
Installation and
Support Guide for
AlX, UNIX, Solaris
and Linux on
POWER,
GC26-7705

IBM TotalStorage
DS4000 Storage
Manager Version 9
Copy Services
User’s Guide,
GC26-7707

IBM TotalStorage
DS4000 Storage
Manager Version 9
Concepts Guide,
GC26-7734

About this document
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Other DS4000 and DS4000-related documents

associates each of the following documents with its related common user
tasks.

Table 8. TotalStorage DS4000 and DS4000-related document titles by user tasks

Title User Tasks

Planning |Hardware Software Configuration |Operation and |Diagnosis and
Installation Installation Administration |Maintenance

IBM Safety
Information, [
33P2406

IBM TotalStorage
DS4000 Quick Start ¥ V
Guide, GC26-7738

IBM TotalStorage
DS4000 Hardware
Maintenance
Manual,GC26-7702

IBM TotalStorage
DS4000 Problem
Determination
Guide, GC26-7703

IBM Fibre Channel
Planning and
Integration: User’s
Guide and Service
Information,
SC23-4329

IBM TotalStorage
DS4000 FC2-133
Host Bus Adapter
Installation and
User’s Guide,
GC26-7736

IBM TotalStorage
DS4000 FC2-133
Dual Port Host Bus
Adapter Installation
and User’'s Guide,
GC26-7737

IBM TotalStorage
DS4000 Fibre
Channel and Serial
ATA Intermix % I % e
Premium Feature
Installation Overview
GC26-7713

Fibre Channel
Solutions - IBM
DS4000 EXP500
Installation and
User’s Guide,
59P5637
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Table 8. TotalStorage DS4000 and DS4000-related document titles by user tasks (continued)

Title

User Tasks

Hardware
Installation

Planning

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStorage
DS4000 EXP700
and EXP710
Storage Expansion
Enclosures
Installation, User’s,
and Maintenance
Guide, GC26-7735

IBM TotalStorage
DS4000 Hard Drive
and Storage
Expansion
Enclosures
Installation and
Migration Guide,
GC26-7704

IBM DS4000
Management Suite
Java User’s Guide,
32P0081

IBM Netfinity® Fibre
Channel Cabling
Instructions,
19K0906

IBM Fibre Channel
SAN Configuration
Setup Guide,
25P2509

How to send your comments

Your feedback is important to help us provide the highest quality of information. If
you have any comments about this document, please either fill out the Readers’
comments form (RCF) at the back of this document and give it to an IBM
representative, or submit it in one of the following ways:
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Chapter 1. Introduction

Scalability is a primary attribute of the IBM TotalStorage DS4000 Storage
Subsystem family. Whenever the need arises, you can expand a DS4000 Storage
Subsystem from its minimum to its maximum capacity configuration. To expand
DS4000 Storage Subsystem configurations you can purchase additional equipment
or, in some cases, migrate equipment from DS4000 Storage Subsystem
configurations previously deployed.

The typical DS4000 Storage Subsystem drive connects to both Controller A and
Controller B. Taken together, these connections represent dual drive loops or a
redundant drive loop pair. You must connect drive loops in pairs to enable
redundant drive loop configurations (two data paths per drive enclosure).

Note: In the DS4800 Storage Subsystem publications, these redundant drive loop
pairs are referred to as redundant drive channel pairs.

provides a list of the maximum allowable number of drives and drive loop
pairs for each DS4000 Storage Subsystem by machine type and model number. It
also specifies storage expansion enclosure license requirements.

Important:

Do not intermix fibre channel devices (such as the DS4300 Storage Subsystem and
EXP500 or EXP710 storage expansion enclosure) and SATA devices (such as the
DS4100 Storage Subsystem and EXP100 storage expansion enclosure) in the
same storage subsystem environment unless you purchase the fibre channel/SATA
intermix premium feature entitlement and upgrade the DS4000 Storage Subsystem
controller firmware to 06.10.11.xx or higher. See ['|BM TotalStorage DS4000 Fibre]
[Channel and Serial ATA Intermix Premium Feature” on page 15| for more
information.

Table 9. Maximum allowable drives and drive loop pairs in DS4000 storage servers

Maximum Storage
Maximum number of |expansion unit

Machine |Model number of [drive loop license
Product name type number |drives pairs requirement
IBM TotalStorage 1724 1SC 14 0 None. The
DS4100 Storage DS4100 Single
Subsystem (Single Controller
Controller model) Storage

Subsystem does
not support

storage
expansion
enclosure
attachment.
IBM TotalStorage 1724 100 56 1 None
DS4100 Storage
Subsystem




Table 9. Maximum allowable drives and drive loop pairs in DS4000 storage

servers (continued)

Maximum Storage
Maximum number of |expansion unit
Machine |Model number of |drive loop license
Product name type number drives pairs requirement
IBM TotalStorage 3542 1RU 38 1 None
FAStT200 Fibre 1RX
Channel Storage
Subsystem
IBM TotalStorage 2RU 66 1 None
FAStT200 High 2RX
Availability (HA) Fibre
Channel Storage
Subsystem*
IBM TotalStorage 3552 1RU 224 2 None
FAStT500 Fibre 1RX
Channel Storage
Subsystem?
IBM TotalStorage 1722 60X 56 1 Purchase
DS4300 Fibre 60U storage
Channel Storage expansion unit
Subsystem entitiements in
increments up to
three storage
expansion units
per DS4300
Storage
Subsystem.
IBM TotalStorage 112 1 None. The
DS4300 Fibre DS4300 (with
Channel Storage Turbo option)
Subsystem (with includes a seven
Turbo option) storage
expansion unit
entitlement.
IBM TotalStorage 6LU 14 0 None. The
DS4300 Fibre 6LX DS4300 Single
Channel Storage Controller
Subsystem (Single Storage
Controller model) Subsystem does
not support
storage
expansion
enclosure
attachment.
IBM TotalStorage 1742 1RU 224 2 None
DS4400 Fibre 1RX
Channel Storage
Subsystem?
IBM TotalStorage 1742 90X 224 2 None
DS4500 Fibre 90U

Channel Storage
Subsystem?
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Table 9. Maximum allowable drives and drive loop pairs in DS4000 storage
servers (continued)

Maximum Storage
Maximum number of | expansion unit

Machine |Model number of [drive loop license
Product name type number |drives pairs requirement
IBM TotalStorage 1815 82x or 224 2 None
DS4800 Fibre 84x
Channel Storage 2
Subsystem?
Notes:

1. The maximum number of drives supported by the FAStT200 HA Storage Subsystem
(models 2RU and 2RX) assumes attachment to 4 14-drive storage expansion enclosures
containing 56 fibre channel drives.

2. The maximum number of drives supported by FAStT500, DS4400, DS4500, and DS4800
Storage Subsystems assumes their attachment to 16 14-drive storage expansion
enclosures.

Intermixing storage expansion enclosures

This section contains information on the following topics:
+ |Intermixing EXP500 and EXP700 storage expansion enclosures|
+ [Intermixing EXP700 or EXP100, and EXP710 storage expansion enclosures|

For important information about using the Intermix premium feature, including
configuration and setup requirements, see ['IBM TotalStorage DS4000 Fibre]
[Channel and Serial ATA Intermix Premium Feature” on page 15

For hardware compatibility, ensure that the environmental service module (ESM)
firmware for each storage expansion enclosure and the storage server controller
firmware are either at or above the levels that are recommended in
[page 37|and [Table 23 on page 38}

DS4000 Storage Subsystems support the addition of external drive enclosures by:

* Providing additional storage capacity (as in the case of DS4400 and DS4500
Storage Subsystems)

* Enabling the expansion of a storage subsystem’s capacity beyond that of a given
DS4000 Storage Subsystem chassis (as in the case of DS4100 and DS4300
Storage Subsystems)

When increasing the capacity of your storage subsystem in either of these ways,
you might choose to add external drive enclosures of the same model and type or
of different types. IBM does not support the combination of every DS4000 external
drive enclosure type and model in every DS4000 Storage Subsystem configuration.
Restrictions on the connection of drive enclosures that differ by model and type to
DS4000 Storage Subsystems are documented in this section.

[Table 10 on page 4]indicates, by model, which DS4000 expansion enclosures can
coexist in the same redundant drive loop of a DS4000 Storage Subsystem.
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Table 10. Mixed DS4000 expansion enclosure compatibility in storage subsystems by model

DS4000 expansion DS4000 DS4000 DS4000 DS4000

enclosure EXP100 (SATA) | EXP500 (Fibre [EXP700 (Fibre |EXP710 (Fibre
Channel) Channel) Channel)

IBM TotalStorage e 1| »HA »HA

DS4000 EXP100

(SATA)

IBM TotalStorage d 4 -

DS4000 EXP500 (Fibre (1 Gbps only) (1 Gbps only)

Channel)

IBM TotalStorage »HA »H +»H B

DS4000 EXP700 (Fibre (1 Gbps only)

Channel)

IBM TotalStorage »HA e 5 | e 5 |

DS4000 EXP710 (Fibre

Channel)

Requires controller firmware 06.10.11.xx or higher (DS4300 with Turbo option, DS4400,
and DS4500), 06.12.03.xx or higher (DS4300 Base, DS4100 Base) or 06.14.xx.xx (DS4800).
Note: There are versions of 05.41.xx.xx controller firmware that also provide DS4000
EXP100 support for DS4300 (with Base or Turbo option), DS4400, and DS4500 Storage
Subsystems or versions of 05.42.xx.xx xx controller firmware that also provide DS4000
EXP100 support for DS4100 Storage Subsystems. However, IBM recommends that you use
controller firmware version 06.12.xx.xx for the DS4100, DS4300 (with Base or Turbo option),
DS4400, and DS4500 Storage Subsystems, instead.

H Supported only with fibre channel/SATA intermix entitlement purchase and controller
firmware version 06.10.11.xx or higher. In addition, the storage subsystem must also be in
the DS4000 Storage Subsystem list that support FC/SATA intermix premium feature.

H Requires controller firmware 05.2x.xx.xx or higher.
B Requires controller firmware 04.xx.xx.xx or higher.

B Requires controller firmware 06.10.11.xx or higher.

able 11} indicates what DS4000 expansion enclosures can attach to DS4000
Storage Subsystems by model.

Table 11. DS4000 expansion enclosure compatibility with DS4000 Storage Subsystems by
model

DS4000 storage DS4000 DS4000 DS4000 EXP700 |DS4000 EXP710

device EXP100 (SATA) | EXP500 (Fibre [ (Fibre Channel) | (Fibre Channel)
Channel)

DS4100 Storage I

Subsystem (Base

model, SATA)

DS4100 Storage
Subsystem (Single
Controller model,

SATA)

FAStT200 Storage I 4
Subsystem (Fibre (1 Gbps only) (1 Gbps only)
Channel)
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Table 11. DS4000 expansion enclosure compatibility with DS4000 Storage Subsystems by
model (continued)

FAStT500 Storage I I
Subsystem (Fibre (1 Gbps only) (1 Gbps only)
Channel)

DS4300 Storage v -
Subsystem (Base
model, Fibre
Channel)

DS4300 Storage
Subsystem (Single
Controller model,
Fibre Channel)

DS4300 Storage ~AH »A Al
Subsystem (Turbo

option, Fibre
Channel)

DS4400 Storage »HA - +»HA Al
Subsystem (Fibre (1 Gbps only)
Channel)

DS4500 Storage e 2 | - e 2 | Al
Subsystem (Fibre (1 Gbps only)
Channel)

DS4800 Storage 2 ANl
Subsystem (Fibre
Channel)

The DS4300 base will support FC/SATA intermix only when the controller firmware is of
version 06.12.xx.xx or higher and the fibre channel/SATA intermix entitlement is purchased.

In addition, although the DS4300 Storage Subsystem (Base model) will support fibre channel
or SATA drives with controller firmware version 05.41.xx.xx, it will not support both in a mixed
environment. It will, however, support SATA drives in an attached storage enclosure (only),
but never in the DS4300 Storage Subsystem, itself. In addition, before the DS4300 Storage
Subsystem (Base model) will support a DS4000 EXP100 drive enclosure, it is necessary to
remove all fibre channel drives from the DS4300 chassis.

H The intermix of DS4000 EXP700 and EXP710 fibre channel drive enclosures with
DS4000 EXP100 SATA drive enclosures in a given DS4000 Storage Subsystem is supported
only with fibre channel/SATA intermix entittement purchase and controller firmware version
06.10.11.xx or higher. The DS4800 Storage Subsystems do not support the attachment of
EXP700 drive expansion enclosures. You must upgrade the EXP700 drive expansion
enclosure to EXP710 before attaching to the DS4800 Storage Subsystem.

E] DS4000 Storage Subsystems require the following firmware to manage EXP100
expansion enclosures.

DS4300 Base or Turbo and DS4500
Either 05.41.5x.xx or 06.1x.xx.xX. Version 06.12.xx.xx or higher is recommended.

DS4400
06.1x.xx.xx. Version 06.12.xx.xx or higher is recommended.

DS4800
Version 06.14.xx.xx or higher is recommended.

A Requires controller firmware version 06.1x.xx.xx or higher. Version 06.12.xx.xx or higher
is recommended for DS4300 Base or Turbo, DS4400 and DS4500. For DS4800, version
06.14.xx.xx or higher is recommended.
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Currently, IBM supports three different storage expansion enclosure models -
EXP100, EXP700 and EXP710. lists those drive expansion enclosure
models that are considered of the same storage enclosure type for the purpose
grouping together in an intermixed SATA/fibre channel storage expansion enclosure
loop configuration.

Table 12. DS4000 drive expansion enclosure models compatible in intermixed loop
configurations only when contiguously grouped

Group-compatible EXP100 Group-compatible EXP700 Group-compatible
models models EXP710 models
1710-10X 1740-1RU 1740-710
1710-10U 1740-1RX 1740-1RU?*
1724-1XP 1740-1RX*

1. Consider and treat this EXP700 model as an EXP710 for grouping purposes only once
upgraded with the DS4000 EXP700 field upgrade to switched ESMs.

You can mix DS4000 TotalStorage EXP500 (which operates only at 1 Gbps) and
DS4000 TotalStorage EXP700 (which operates at either 1 Gbps or 2 Gbps) storage
expansion enclosures in the same redundant drive loop pair in all DS4400 and
DS4500 Storage Subsystem configurations. There is no restriction to the physical
sequence of mixed EXP700 and EXP500 expansion units in the same redundant
drive loop pair. You cannot mix these enclosures in the same redundant drive loop
pair in DS4100, DS4300 and DS4800 Storage Subsystem configurations.

The DS4100 Storage Subsystems support only the DS4000 EXP100 storage
expansion enclosures. The DS4300 Storage Subsystems support only 2 Gbps
storage expansion enclosures, such as the DS4000 EXP700/EXP710 or the
DS4000 EXP100. The DS4800 Storage Subsystem supports only the DS4000
EXP710 or the DS4000 EXP100 storage expansion enclosures. See |Tab|e 11 0n|
page 4] See [‘Intermixing EXP500 and EXP700 storage expansion enclosures” on|
page 7|for additional information.

When connecting the DS4000 EXP500 and EXP700 enclosures in the same
DS4000 Storage Subsystem, although the EXP700 storage expansion enclosure is
capable of operating at 2 Gbps, you must set the fibre channel speed of drive loops
in a mixed storage expansion enclosure environment to the lowest fibre channel
speed supported by all hardware in the loop, which is 1 Gbps. If one of the drive
loops in a DS4000 Storage Subsystem configuration is set to 1 Gbps, you must set
all of the drive loops to 1 Gbps. This speed restriction applies to all four drive loops
in either the DS4400 or DS4500 Storage Subsystem configuration, even where
some of the drive loops consist only of EXP700 storage expansion enclosures that
might otherwise operate at 2 Ghps.

Although you can intermix DS4000 EXP700 storage expansion enclosures and
DS4000 EXP100 with EXP710 storage expansion enclosures in the same
redundant drive loop pair in a DS4000 Storage Subsystem configuration, you must
group together all DS4000 EXP710 storage expansion enclosures in the redundant
drive loop. See ['Intermixing EXP700 or EXP100, and EXP710 storage expansion|
[enclosures” on page 9[and|[Table 12[for additional information.

Do not intermix DS4000 EXP500 (which operates only at 1 Gbps) and DS4000
EXP710 or EXP100 (which operate only at 2 Gbps) storage expansion enclosures
in the same redundant drive loop pair. Also, do not attach these storage expansion
enclosures to the same controller.
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Although there are no restrictions against cabling DS4000 EXP100 and DS4000
EXP700 storage expansion units together. For ease of future maintenance and
possible troubleshooting, however, IBM recommends that you group or plan your
configuration to allow for grouping of all DS4000 drive expansion enclosures by
type in a DS4000 Storage Subsystem redundant drive loop, if possible.

Attention:  Even though IBM supports intermixing different drive expansion
enclosure models in the same redundant drive loop, we recommend use of a single
drive expansion enclosure model (for example, EXP100, EXP500, EXP700, or
EXP710) in a given redundant drive loop. This is the best practice.

Important:

Do not change the speed of a drive loop while the DS4000 Storage Subsystem is
powered on. Such a speed change will cause unpredictable results.

To change the speed of a drive loop:

___Step 1. Prepare applications for DS4000 Storage Subsystem shutdown.
___ Step 2. Shutdown the DS4000 Storage Subsystem.

___Step 3. Shutdown the DS4000 storage expansion enclosures.

___Step 4. Change the fibre channel speed settings.

___Step 5. Power on the DS4000 storage expansion enclosures.

__Step 6. Power on the DS4000 Storage Subsystem.

___ Step 7. Restore DS4000 Storage Subsystem host application operations.

Note: For additional information on turning a storage server on and off, see the
DS4000 Storage Subsystem Installation, User’s, and Maintenance Guide.
For more information on these guides, see the following Web site:

www.ibm.com/servers/storage/support/disk/|

See ['DS4000 Storage Subsystem drive loop schemes” on page 21 and [‘Setting|
[enclosure IDs” on page 26| for details on cabling DS4000 Storage Subsystems and
storage expansion enclosures together as well as setting their enclosure IDs.

Intermixing EXP500 and EXP700 storage expansion enclosures

[Figure 2 on page §lillustrates cabling of DS4000 TotalStorage EXP500 and EXP700
storage expansion enclosures in a mixed configuration.
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Figure 2. DS4000 EXP500 and EXP700 cabling in a mixed configuration

There are maximum limits to the number of fibre channel hard drives that you can
configure in redundant drive loop pairs. The maximum number of drives dictates a
fixed number of supported EXP500 and EXP700 drive enclosure
combinations|Table 13 on page 9| lists the numbers of EXP500 and EXP700 storage
expansion enclosures that you can combine for use in a single redundant drive loop
pair. [Table 13 on page 9 assumes that a DS4000 Storage Subsystem is generally
capable of addressing the maximum of 112 fibre channel hard drives for each
redundant drive loop pair.

Important:

IBM supports only those EXP500 and EXP700 Storage Expansion Unit
combinations listed in [Table 13 on page 9|
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Table 13. Supported EXP500 and EXP700 combinations per maximum redundant drive loop
pair drives

Total number of Total number of Maximum number of | Maximum number
EXP500 enclosures EXP700 enclosures | storage expansion of drives per
per redundant drive per redundant units per redundant |redundant drive
loop pair drive loop pair drive loop pair loop pair

11 0 11 110

10 0 10 100

9 1 10 104

8 2 10 108

7 3 10 112

6 3 9 102

5 4 9 106

4 5 9 110

3 6 9 114

2 6 8 104

1 7 8 108

0 8 8 112

Note: The combination of three EXP500 and six EXP700 storage expansion
enclosures has the maximum number of 114 drives per redundant drive loop
pair. You can have this maximum number of hard drives per drive loop pair
only in this mixed EXP500 and EXP700 configuration.

Intermixing EXP700 or EXP100, and EXP710 storage expansion

enclosures

Attention: Before intermixing EXP710 and EXP100 drive expansion enclosures in
a DS4000 Storage Subsystem you must purchase IBM TotalStorage DS4000 SATA
and fibre channel storage expansion enclosure intermix entitlement and carefully
read this section.

It is possible to intermix EXP700 or EXP100, and EXP710 storage expansion
enclosures in the same drive loop. To do so, however, you must group all of the
EXP710 storage expansion enclosures together to enable the EXP710 Reliability
and Serviceability (RAS) features and to optimize the data transfering between the
EXP710 enclosures. [Figure 3 on page 11| through [Figure 4 on page 12|illustrate two
acceptable EXP700 and EXP710 intermixing cabling configurations in which all
EXP710 storage expansion enclosures are grouped together. [Figure 5 on page 13|
shows an acceptable configuration that is not recommended because it could
present cabling problems later on if you add new EXP710 drive enclosures to a
redundant drive loop that is already configured. [Figure 6 on page 14| and [Figure 7|

show two unacceptable intermixed configurations in which all EXP710

storage expansion enclosures are not grouped together.

These intermixing requirements must also be met if you are upgrading some (but
not all) of the EXP700 storage expansion enclosures in a drive loop with the
EXP700 Models 1RU/1RX Switched-ESM Option Upgrade Kit (P/N 25R0166). Once
upgraded, these EXP700 drive expansion enclosures are considered EXP710 drive
expansion enclosures, even though the machine type and models might be still be
shown as EXP700 machine types and models.
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Important:

IBM does not support any configuration in which EXP710 drive expansion
enclosures are not grouped together.

[Figure 3 on page 11|though [Figure 5 on page 13| show three acceptable EXP700
and EXP710 intermixing cabling configurations in which all EXP710 storage
expansion enclosures are grouped together. Note that in |Figure 5 on page 13} the
EXP710 storage expansion enclosures are grouped together, even though the
EXP700 storage expansion enclosures are not grouped together.

Although illustrations [Figure 3 on page 11| through [Figure 7 on page 15|incorporate
the DS4000 DS4300 Storage Subsystem for the sake of example, other DS4000
storage servers might be acceptable replacements. The DS4000 EXP100 would
also intermix successfully with an EXP710 when substituted for an EXP700 in an
equivalent loop configuration.
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Figure 5. Acceptable (not recommended) intermixed EXP700 (or EXP100) and EXP710 loop
configuration (3 of 3)

In|Figure 6 on page 14 and [Figure 7 on page 15| the intermixed configurations
shown are not supported because the EXP710 storage expansion enclosures in the
redundant drive loop are not grouped together. When substituting a DS4000
EXP100 for an EXP700 enclosure in an equivalent drive loop cabling configuration,
the intermixed drive loop cabling is also not supported.
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2)

IBM TotalStorage DS4000 Fibre Channel and Serial ATA Intermix
Premium Feature

Note: For the most current information on the DS4000 Fibre Channel and SATA
(FC/SATA) Enclosure Intermix premium feature, see the IBM TotalStorage
Support Web site:

http://www-1.ibm.com/servers/storage/support/disk/
The DS4000 FC/SATA Intermix premium feature supports the concurrent attachment

of Fibre Channel and SATA storage expansion enclosures to a single DS4000
controller configuration. With this premium feature, you can create and manage
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distinct arrays that are built from either Fibre Channel disks or SATA disks and
allocate logical drives to the appropriate applications using a single DS4000
Storage Subsystem.

The TotalStorage DS4500, DS4400, and DS4300 with Standard/Base or Turbo
options storage subsystems with this premium feature can support the attachment
of DS4000 EXP700 and EXP710 Fibre Channel Disk Expansion enclosures and
DS4000 EXP100 Serial ATA Disk Expansion enclosures concurrently. The
TotalStorage DS4800 with this premium feature supports the attachment of DS4000
EXP710 Fibre Channel and EXP100 SATA drive expansion enclosures concurrently.
Please contact IBM for information regarding future DS4000 Storage Subsystem
support.

The FC/SATA Intermix premium feature requires that you upgrade the DS4500,
DS4400, or DS4300 Turbo storage subsystems to DS4000 Storage Manager
version 9.10 or later (controller firmware level 6.10.10.xx or later) in the upgrade
sequence in these instructions. The DS4800 is shipped with controller firmware
version 06.14.xx.xx or later and the required DS4000 Storage Manager version 9.14
or later, so no upgrades would be required for the DS4800.

The FC/SATA Intermix Option installation kit includes the following items:

* The IBM TotalStorage DS4000 Fibre Channel and Serial ATA Intermix Premium
Feature Installation Overview

* The DS4000 FC/SATA Intermix premium feature entitlement document

* The DS4000 FC/SATA Intermix premium feature activation document, which
includes the feature activation code and the instructions about how to generate
the key file

* The DS4000 Storage Subsystem NVSRAM Support for DS4000 FC/SATA
Enclosure Intermix CD

Note: The NVSRAM file in this CD is for the DS4000 Storage Subsystems with
controller firmware version 06.10.xx.xx only. Do not use this NVSRAM file
if the DS4000 Storage Subsystems have controller firmware version
06.12.xx.xx or later installed. Use the NVSRAM files that are packaged
with the version 06.12.xx.xx or later DS4000 Storage Subsystem controller
firmware packages instead.

The FC/SATA Intermix premium feature installation

To use the FC/SATA Intermix premium feature upgrade, perform the following steps:

1. Purchase an IBM TotalStorage DS4000 Fibre Channel/SATA Intermix
entittement. Contact your IBM reseller or representative for additional
information.

2. Upgrade your DS4000 ESM firmware to the level that is compatible with each
particular enclosure type.

Attention: You should perform any ESM code upgrades that are required
before you perform any other code upgrades.

[Table 14 on page 17|indicates which ESM firmware levels are compatible with
each enclosure type.
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Table 14. ESM firmware levels by storage expansion enclosure type

Storage expansion enclosure type ESM firmware level

DS4000 EXP100 9554 (See note a below)

DS4000 EXP700 9326 or later (See notes b and ¢ below)

DS4000 EXP710 9627 or later (See note d below)
Notes:

3.

a. You must upgrade the EXP100 ESM firmware to version 9554 first on those
DS4000 Storage Subsystems on which the controller firmware version
05.41.1x.xx is installed. The EXP100 ESM firmware cannot be upgraded to
version 9554 on those DS4000 Storage Subsystems on which other
versions of controller firmware are installed.

b. You must upgrade the EXP700 ESM firmware to version 9326 or later
before you upgrade the DS4000 Storage Subsystem controller firmware to
version 06.1X.XX.XX.

c. The DS4800 Storage Subsystem does not support DS4000 EXP700 drive
expansion enclosures.

d. The EXP710 ESM firmware must be at version 9629 or later for DS4800
configurations.

If necessary, upgrade your host software to DS4000 Storage Manager version
9.10 or later. You can download upgrades for the applicable DS4000 storage
subsystem over the Internet from the IBM DS4000 Storage Manager Support
Web site. Refer to the Storage Manager Installation and Support Guide for your
operating system.

Upgrade your DS4000 Storage Subsystem controller firmware to version
06.10.10.xx or later to use with DS4000 Storage Manager host software version
9.10 or later. IBM recommends the controller firmware version 06.12.xx.xx and
later for the DS4300, DS4400 and DS4500 Storage Subsystems and
06.14.xx.xx and later for DS4800 Storage Subsystems. For more information,
refer to the IBM DS4000 Storage Manager Installation and Support Guide for
the appropriate operating system of the host computer on which the DS4000
Storage Manager host software will be installed or upgraded.

The latest versions of the DS4000 Storage Subsystem controller firmware and
the host software are available for download over the Internet from the DS4000
TotalStorage Support Web page:

www.ibm.com/servers/storage/support/disk/|

Upgrade your DS4000 storage subsystem controller NVSRAM to the
appropriate version of NVSRAM files based on the controller firmware version
as indicated below.

Attention: To verify the DS4000 Storage Subsystem controller firmware
version, right-click the controller icon in the Subsystem Management window of
the DS4000 Storage Subsystem that you are working on. Select Properties in
the pull-down list and, when the Properties window opens, look for the value on
the right of the Firmware Version field.

If the installed controller firmware is of version 06.10.XX.XX
To implement the FC/SATA Intermix feature, download the appropriate
NVSRAM file from the DS4000 Storage Subsystem NVSRAM Support
for DS4000 FC/SATA Enclosure Intermix CD that is associated with your
host operating system. The filenames of the NVSRAM files that enable
the FC/SATA intermix premium feature have an “I” character prefix, for
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example, 11742F900R910V04.dIp. The appropriate NVSRAM file for a
given storage subsystem can be found in one of the following
directories:

* \NVSRAM\DS4300_FAStT600turbo
* \NVSRAM\DS4400_FAStT700
* \NVSRAM\DS4500_FAStT900

Notes:

a. The controller firmware of the DS4300 Storage Subsystem with
Standard/Base option must be at 06.12.xx.xx or later in order to
support the DS4000 FC/SATA Intermix premium feature.

b. The DS4800 Storage Subsystems are released with controller
firmware version 06.14.xx.xx. There are no previous versions of
controller firmware for it.

If the installed controller firmware is of version 06.12.xx.xx or later

Attention: Do not use the NVSRAM file in the DS4000 Storage
Subsystem NVSRAM Support for DS4000 FC/SATA Enclosure Intermix
CD. Install the appropriate NVRAM for your DS4000 Storage
Subsystem that is packaged with the controller firmware that you
installed in the DS4000 Storage Subsystem in step
above.

The DS4000 FC/SATA Intermix premium feature is entitled and requires
the use of a feature key to enable the option. To obtain the feature key
identifier, you need a feature activation code, which is printed on the
IBM premium feature activation card. You also need your controller unit
IBM serial number, which is printed on the label on the back of your
DS4000 Storage Subsystem. Follow the instructions in the FC/SATA
intermix premium feature activation card for instructions about how to
generate the required feature key and enable the FC/SATA intermix
premium feature.

Attention:

For DS4000 Storage Subsystems with controller firmware version 06.10.xX.XX
installed, the FC/SATA Intermix premium feature is activated when you download
the NVSRAM file. Nonetheless, you MUST generate the premium feature key and
retain it because you will need it to activate the FC/SATA Intermix premium feature
when the controller firmware is upgraded to version 06.12.xx.xx or higher.

If you try to use the premium feature activation key with controller firmware version
06.10.xx.xx, you will get an error message that the Premium Feature that you are
attempting to enable with this feature key file is not supported on the current
configuration of this subsystem.

For the DS4000 Storage Subsystems with the controller firmware version
06.12.xx.xx or later installed, you must generate the premium feature key file to
enable the FC/SATA intermix feature. You cannot use the NVSRAM files included in
the DS4000 FC/SATA Enclosure Intermix CD.

For more information about how to enable the premium feature or the feature key,
read the activation instructions or contact your IBM representative.
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Restrictions

Important: When you add drive expansion enclosures of different types, if the

grouping of the enclosure types forces the new enclosures to be cabled
in the middle of the drive loop, it is strongly recommended that you
power down the configuration or schedule your installations during
offpeak 1/0O periods. You can use the performance monitor function in
the DS4000 Storage Manager Subsystem Management window to
determine offpeak 1/0 periods.

If you cannot power down the configuration to install a new enclosure in
the middle of the loop, you must use the DS40000 Storage Manager
Subsystem Management window to verify that the interrupted drive loop
is up and optimal before you modify the other drive loop. This
minimizes the chance that arrays will fail because of cabling errors.

Therefore, it is also important to plan for additions to the configuration
prior to your initial installation. It is also best practice to take these
same precautions when you add new enclosures to either end of the
redundant drive loop.

The following restrictions apply to the use of the DS4000 FC/SATA Intermix
premium feature:

Compatible storage subsystems

Only the following DS4000 Storage Subsystems support the FC/SATA
Intermix premium feature:

* DS4300 Standard/Base or Turbo
* DS4400
* DS4500
+ DS4800

Contact IBM for information regarding future DS4000 Storage Subsystem
support.

Grouping DS4000 storage expansion enclosures in a redundant drive loop

Attention:

Configurations that do not follow the DS4000 storage expansion enclosures
grouping restriction are not supported.

You must group like DS4000 storage expansion enclosure types in adjacent
positions on the Fibre Channel loop when they are intermixed in a DS4000
Storage Subsystem redundant drive loop configuration. [Figure 8 on page 20|
shows two ways to group your expansion enclosures.
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Figure 8. Correct and incorrect ways to group DS4000 storage expansion enclosures in a
redundant drive loop

You must group like enclosure types together, regardless of type, as the
configuration on the left shows. In the configuration on the left, the
EXP700s are grouped together at the top of the loop, followed by the
EXP710s, which are grouped together at the middle of the loop, followed by
the EXP100s which are grouped together closest to the controller. The
storage expansion enclosure types are indicated in the expansion unit types
indicated in the lower right corner of each enclosure.

In the configuration on the right, the enclosures are cabled in a random
order and are not grouped by type. IBM does not support DS4000 storage
subsystem configurations when they are cabled in this way.

Note: For the purposes of the storage expansion enclosures grouping
restriction, note the following considerations:

» All models of the EXP100 are considered to be the same from a
grouping perspective. For example, the EXP100 1710-10X,
1710-10U, and the 1724-1XP are considered like enclosure types
and must be grouped together.
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» All models of the EXP700 are considered to be the same from a
grouping perspective. For example, the EXP700 1740-1RU, and
the 1740-1RX are considered like enclosure types and must be
grouped together.

* Once the EXP700 has been upgraded with the EXP710 ESM
firmware, it is considered an EXP710, regardless of the machine
type and model.

Cannot mix drive types
Arrays must consist exclusively of either Fibre Channel or SATA drives. You
cannot mix drive types in an array.

You cannot mix Fibre Channel and SATA drives in the same DS4000
Storage Subsystem or storage expansion enclosure. lists the drive
types and their corresponding DS4000 Storage Subsystems and storage
expansion enclosures.

Table 15. Drive types and their corresponding DS4000 Storage Subsystem and storage
expansion enclosures

Drive type Storage subsystem type Storage expansion
enclosure type
SATA DS4100 DS4000 EXP100
Fibre Channel DS4300 Standard/Base DS4000 EXP700
or Turbo DS4000 EXP710
DS4400
DS4500
DS4800

Cannot intermix drive types for hot spares
SATA drives can function as hot spares for SATA drives only.

Fibre Channel drives can function as hot spares for Fibre Channel drives

only.

DS4300 Standard/Base or Turbo intermix configuration restrictions
In DS4300 intermix configurations, if the FC/SATA Intermix premium feature
is enabled along with the correct NVSRAM for Intermix is installed, the
maximum number of expansion enclosures in a drive loop is limited to
seven, regardless of whether there are drives in the DS4300 Storage
Subsystem drive slots.

DS4000 Storage Subsystem drive loop schemes

Although a variety of cable loop schemes might function acceptably, IBM
recommends consistent use of only one such scheme when connecting DS4000
Storage Subsystems and expansion enclosures. [Figure 9 on page 22| illustrates the
only cable loop scheme that IBM recommends when connecting DS4000 Storage
Subsystems and expansion enclosures.
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Figure 9. Recommended cable loop scheme for connecting DS4000 storage devices

Legend:

Integrated drive/controller DS4000 Storage Subsystem (for example,
DS4300 or DS4100)

2 Controller only DS4000 Storage Subsystem (for example, DS4400 or
DS4500)

IBM recommends against inconsistent use of any cable loop scheme. Even though
cable loop schemes illustrated in [Figure 10 on page 23| and [Figure 11 on page 24|
are acceptable when connecting DS4000 Storage Subsystems and expansion
enclosures, IBM recommends against their use because they are not standardized
for IBM DS4000 Support.

Attention: Do not make the cable schemes illustrated in |Figure 12 on page 25|
or [Figure 13 on page 26| because they will affect the diagnostic ability in the event
of drive loop failures.

IBM recommends against inconsistent use of any cable loop scheme. IBM also
recommends against the use of the cable loop schemes shown in the following
illustrations when connecting DS4000 Storage Subsystems and expansion
enclosures because they are not standardized for IBM DS4000 Support.
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Figure 10. Possible (but not recommended) alternate cable loop scheme for when connecting
DS4000 storage devices

Legend:

Integrated drive/controller DS4000 Storage Subsystem (for example,
DS4300 or DS4100)

2 | Controller only DS4000 Storage Subsystem (for example, DS4400 or
DS4500)
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Figure 11. Possible (but not recommended) alternate cable loop scheme for connecting
DS4000 storage devices

Legend:

Integrated drive/controller DS4000 Storage Subsystem (for example,
DS4300 or DS4100)

2 Controller only DS4000 Storage Subsystem (for example, DS4400 or
DS4500)
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Figure 12. Unacceptable cable loop scheme for connecting DS4000 storage devices

Legend:

2]

Integrated drive/controller DS4000 Storage Subsystem (for example,

DS4300 or DS4100)

Controller only DS4000 Storage Subsystem (for example, DS4400 or

DS4500)
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Figure 13. Unacceptable cable loop scheme for connecting DS4000 storage devices

Legend:

Integrated drive/controller DS4000 Storage Subsystem (for example,
DS4300 or DS4100)

2 | Controller only DS4000 Storage Subsystem (for example, DS4400 or
DS4500)

Setting enclosure IDs

Each drive enclosure in a DS4000 Storage Subsystem drive loop must have a
unigue drive enclosure ID. DS4000 controllers use a combination of the enclosure
ID and the number of the physical slot that a hard drive occupies to create a unique
loop address or arbitrated loop physical address (AL_PA) for each drive in a drive
loop. The enclosure ID consists of two digits, a tens (x10) digit and a ones (x1)
digit. The possible values for the tens and the ones digits are 0-9 for FAStT500
drive enclosures, and 0-7 for DS4400 drive enclosures.

It is recommended as best practice that you give each drive expansion enclosure in
a redundant drive loop a unique ones digit ID. This setting will enforce hard AL_PAs
(unchangeable between Loop Initializations [LIPs]) for the drives and facilitate drive
loop problem troubleshooting in the event of an error. If the ones digits are not
unique, two or more devices will have the same hard AL_PA. In such a case, the
controller will use soft AL_PAs for the devices that have identical hard AL_PAs.

The problem with soft addressing is that addresses can change between LIPs. This

possibility increases the difficulty of troubleshooting drive loop problems because it
is difficult to ascertain whether the same device with a different address or a
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different device might be causing a problem. Because the DS4000 Storage
Subsystem can support more enclosures than available values of the enclosure 1D

ones digit, through [Table 20 on page 30| suggest enclosure ID settings for

various drive expansion enclosure families to minimize soft addressing in a drive

loop.

Table 16. EXP500 Storage Expansion Enclosure ID settings

Storage expansion enclosure

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop if
applicable/supported

1st unit

(storage expansion enclosure
or storage server with internal
drive slots)

00

x0
(where x is 2-7)

2nd unit 01 x1
(EXP500) (where x is 2-7)
3rd unit 02 X2
(EXP500) (where x is 2-7)
4th unit 03 x3
(EXP500) (where x is 2-7)
5th unit 04 x4
(EXP500) (where x is 2-7)
6th unit 05 x5
(EXP500) (where x is 2-7)
7th unit 06 X6
(EXP500) (where x is 2-7)
8th unit 07 X7
(EXP500) (where x is 2-7)
9th unit 08 x8
(EXP500) (where x is 2-7)
10th unit 09 x9
(EXP500) (where x is 2-7)
11th unit 10 x0
(EXP500) (where x is 3-7)

Note: Drives in the 11th enclosures of each drive loop in|Table 16 will have soft

AL_PAs.

able 17| suggests enclosure ID settings that minimize soft addressing for EXP100
storage expansion enclosures in a drive loop.

Table 17. EXP100 Storage Expansion Enclosure ID settings

Storage expansion enclosure
(unmixed)

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop if
applicable/supported

1st unit

(EXP100 Expansion Enclosure
or DS4000 Storage Subsystem
with internal drive slots)

00

x0
(where x is 2-7)
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Table 17. EXP100 Storage Expansion Enclosure ID settings (continued)

Storage expansion enclosure
(unmixed)

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop if
applicable/supported

2nd unit 01 x1

(EXP100) (where x is 2-7)
3rd unit 02 X2

(EXP100) (where x is 2-7)
4th unit 03 x3

(EXP100) (where x is 2-7)
5th unit 04 x4

(EXP100) (where x is 2-7)
6th unit 05 x5

(EXP100) (where x is 2-7)
7th unit 06 X6

(EXP100) (where x is 2-7)
8th unit 07 X7

(EXP100) (where x is 2-7)
9th unit 11

(EXP100, where the first unit is
a DS4300 only)

Note: All drives in drive loops described in[Table 17 on page 27| will be assigned

hard AL_PAs.

able 18| suggests enclosure ID settings that minimize soft addressing for EXP700

or EXP710 storage expansion enclosures in a drive loop.

Table 18. EXP700 or EXP710 Storage Expansion Enclosure ID settings

Storage expansion enclosure
(unmixed)

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop if
applicable/supported

1st unit

(storage expansion enclosure
or DS4000 Storage Subsystem
with internal drive slots)

00

x0
(where x is 2-7)

2nd unit 01 x1
(EXP700) (where x is 2-7)
3rd unit 02 X2
(EXP700) (where x is 2-7)
4th unit 03 x3
(EXP700) (where x is 2-7)
5th unit 04 x4
(EXP700) (where x is 2-7)
6th unit 05 x5
(EXP700) (where x is 2-7)
7th unit 06 X6
(EXP700) (where x is 2-7)
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Table 18. EXP700 or EXP710 Storage Expansion Enclosure ID settings (continued)

Storage expansion enclosure
(unmixed)

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop if
applicable/supported

8th unit
(EXP700)

07

X7
(where x is 2-7)

Note: All drives in drive loops described in[Table 18 on page 28| will be assigned

hard AL_PAs.

able 19| suggests enclosure ID settings that minimize soft addressing for the
EXP500 and EXP700 Storage Expansion Enclosure when intermixed in a redundant

drive loop.

Table 19. Intermixed EXP500 and EXP700 Storage Expansion Enclosure ID settings

Storage expansion enclosure
models (intermixed)

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop

1st unit

(storage expansion enclosure
or DS4000 Storage Subsystem
with internal drive slots)

00

x0
(where x is 2-7)

2nd unit 01 x1
(EXP500 or EXP700) (where x is 2-7)
3rd unit 02 X2
(EXP500 or EXP700) (where x is 2-7)
4th unit 03 x3
(EXP500 or EXP700) (where x is 2-7)
5th unit 04 x4
(EXP500 or EXP700) (where x is 2-7)
6th unit 05 x5
(EXP500 or EXP700) (where x is 2-7)
7th unit 06 x6
(EXP500 or EXP700) (where x is 2-7)
8th unit 07 X7
(EXP500 or EXP700) (where x is 2-7)
9th unit 10 x0
(EXP500 or EXP700) (where x is 2-7)
10th unit 11 x1

(EXP500 or EXP700)

(where x is 2-7)

Note: The drives in the 9th and 10th enclosures in each drive loop described in
Table 19| will have soft AL_PAs.

[Table 20 on page 30| suggests enclosure ID settings that minimize soft addressing
for the EXP700 and EXP710 Storage Expansion Enclosure when intermixed in a

redundant drive loop.
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Table 20. Intermixed EXP700 and EXP710 Storage Expansion Enclosure ID settings

Enclosure ID setting for Enclosure ID setting for
Storage expansion enclosure |enclosure in the first enclosure in the second
models (intermixed) redundant drive loop redundant drive loop
1st unit 00 x0
(storage expansion enclosure (where x is 2-7)
or DS4000 Storage Subsystem
with internal slots)
2nd unit 01 x1
(EXP700 or EXP710) (where x is 2-7)
3rd unit 02 X2
(EXP700 or EXP710) (where x is 2-7)
4th unit 03 x3
(EXP700 or EXP710) (where x is 2-7)
5th unit 04 x4
(EXP700 or EXP710) (where x is 2-7)
6th unit 05 x5
(EXP700 or EXP710) (where x is 2-7)
7th unit 06 X6
(EXP700 or EXP710) (where x is 2-7)
8th unit 07 X7
(EXP700 or EXP710) (where x is 2-7)

Note: The drives in the 9th and 10th enclosures in each drive loop described in

Table 20| will have soft

AL_PAs.

Determining firmware levels

Method one:

There are two different methods to determine DS4000 Storage Subsystem,
expansion unit, drive, and ESM firmware versions. Each method uses the DS4000
Storage Manager client that manages the DS4000 storage subsystem with the

attached expansion unit.

For controllers with firmware version 6.1x.xx.xx or later, go to the Subsystem
Management window and select Storage Subsystem » View Profile. For
controllers with firmware version 5.xx.xx.xx.xx or earlier select View » Storage
Subsystem Profile. When, under either circumstance, the Storage Subsystem
Profile window opens, select the All tab and scroll through the Profile For Storage
Subsystem to locate the following information.

Note: The Profile For Storage Subsystem contains all the profile information for
the entire subsystem. Therefore, it might be necessary to scroll through a
large amount of information to locate the firmware version numbers.

DS4000 Storage Subsystem
* NVSRAM version

* Appware version (Appware is a reference to controller firmware).
* Bootware version (Bootware is a reference to controller firmware.)

30 Adding and Migrating Drives and Expansion Enclosures to DS4000 Storage Servers



Method two:

See the following example or snapshot of profile information.

Controller in Enclosure 0, STlot A
Status: Online

Current configuration

Firmware version: 06.10.07.00
Appware version: 06.10.07.00
Bootware version: 06.10.07.00
NVSRAM version: 1722F600R910V05

Drives

ESM

Firmware version

ESM card firmware version

Select the appropriate procedure from the following options and complete it to
obtain the specified firmware version.

To obtain the controller firmware version:
Right click the Controller icon in the Physical View pane of the Subsystem
Management window and select Properties. The Controller Enclosure
properties window opens and displays the properties for that controller.

You must perform this step for each individual controller.

To obtain the drive firmware version:
Right Click the Drive icon in the Physical View pane of the Subsystem
Management window and select Properties. The Drive Properties window
opens and displays the properties for that drive.

You must perform this step for each individual drive.

To obtain the ESM firmware version:

1.

3.

In the Physical View pane of the Subsystem Management window, click
the Drive Enclosure Component icon (which is the icon furthest to the
right). The Drive Enclosure Component Information window opens.

Click the ESM icon in the left pane. The ESM information displays in the
right pane of the Drive Enclosure Component Information window.

Locate the firmware version of each ESM in the drive enclosure.

To obtain the drive enclosure component firmware version:

1.

Click the Drive Enclosure Component icon (the icon located furthest to
the right) in the Drive Enclosure frame in the Physical View pane of the
Subsystem Management window. The Drive Enclosure Component
Information window opens.

Click the ESM icon in the left pane. The ESM information displays in the
right pane of the Drive Enclosure Component Information window.

Locate the firmware version of each ESM in the drive enclosure.
You must perform this step for each drive expansion enclosure.
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Determining the product ID and model of a drive

You can determine the product ID and model of a drive from the storage server
profile through the menu option in the DS4000 Subsystem Management window. To
get the profile, in the DS4000 Subsystem Management window, either click View »
Storage Subsystem Profile (if the controller firmware version is 05.xx.xx, or
earlier) or Storage Subsystem » View Profile (if the controller firmware version is
06.xx.xx, or later). When the Storage Subsystem Profile window displays, click on
the Drives tab and scroll down to the information about the drive which product 1D
and model you want to verify. Seefor a sample profile indicating the
product ID of the drive in slot 1 of enclosure ID 1 as ST3146807FC.

Table 21. Snapshot of profile information identifying the product ID of the drive in slot 1 of
enclosure ID 1 as ST3146807FC

HOT SPARE COVERAGE:
The following arrays are not protected: 1, 2

Total hot spare drives: 0
Standby: 0
In use: 0

DETAILS:

Drive at Enclosure 1, Slot 1
Drive port: 1, Channel: 1; ID: 8/0xD9
Drive port: 2, Channel: 2; ID: 8/0xD9
Drive path redundancy: OK
Status: Optimal
Raw capacity: 136.732 GB
Usable capacity: 136.732 GB
Current data rate: 2 Gbps
Product ID: ST3146807FC 1#
Firmware version: B350
Serial number: 3HY062YKOO0O7309FAT1
Vendor: IBM-ESXS
Date of manufacture: May 29, 2002
World-wide name: 20:00:00:04:cf:56:43:fb
Drive type: fibre channel
Speed: 10033 RPM
Mode: Assigned
Associated array: 1

Drive at Enclosure 1, Slot 2

Drive port: 1, Channel: 2; ID: 9/0xD9
Drive port: 2, Channel: 1; ID: 9/0xD9
Drive path redundancy: OK

Status: Optimal

Raw capacity: 136.732 GB

Usable capacity: 136.732 GB

Current data rate: 2 Gbps

DS4000 Storage Manager installation and support guides

This publication frequently cites IBM TotalStorage DS4000 Storage Manager
installation and support guides supporting various versions and operating system
environments. There are currently two, namely:

* IBM TotalStorage DS4000 Storage Manager Installation and Support Guide for
AIX, HP-UX, Solaris and Linux on Power
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* IBM TotalStorage DS4000 Storage Manager Installation and Support Guide for
Intel-based Operating System Environments

Visit the following Web site to access documentation related to your particular
operating system and DS4000 Storage Manager version.

www.ibm.com/servers/storage/support/disk/|

See ['DS4000 Storage Subsystem publications” on page xix| for more information.
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Chapter 2. Prerequisites to adding capacity and hard drive

migration

Perform the preliminary steps detailed in this chapter before you add storage

capacity or

migrate hard drives. After you meet these prerequisite requirements,

proceed to any of the following sections to address your particular storage hardware
addition or migration requirements:

+ [Chapter 3, “Adding one or more new hard drives,” on page 45|

[Chapter 5, “Adding expansion units containing new hard drives,” on page 59|

[Chapter 4, “Migrating one or more hard drives,” on page 51|

[Chapter 6, “Migrating expansion units containing hard drives,” on page 77|

+ [Chapter 7, “Upgrading a storage subsystem in a functioning configuration,” on|

page 93|

Failure to perform the steps listed in this section might result in loss of data
availability, and in some cases, loss of data. Perform the following steps on the
DS4000 Storage Subsystem to which you will migrate or add new hard drives:

__ Step 1.

__ Step 2.
__ Step 3.

__ Step 4.

__ Step 5.

__Step 6.

__ Step 7.
__ Step 8.

___Step 9.

© Copyright IBM Corp. 2005

Complete a full backup of all data residing on the DS4000 Storage
Subsystem.

Verify that the backup was successful.

Verify that the DS4000 Storage Subsystem has the latest controller
firmware, non-volatile storage random access memory (NVSRAM), and
ESM firmware.

Attention: If your DS4000 Storage Subsystem has controller firmware
version 04.01.02.29 or lower, download and install controller firmware
version 4.01.02.33 or higher before you download and install controller
firmware version 5.30.xx.xx or higher. There are certain minimum
controller firmware version requirements associated with various drive
expansion enclosures. See [Table 10 on page 4| and [Table 11 on page 4|
for related information.

Verify that the drive firmware is at the latest level. If it is not, see
[‘Upgrading drive firmware levels” on page 39|

Verify that the DS4000 Storage Subsystem to which you will migrate the
hard drives is in optimal state. If it is not, perform the appropriate steps
listed in the Recovery Guru to bring the storage subsystem into optimal
state.

Use the Read_Link_Status function of the Storage Manager client
program and the DS4000 Storage Subsystem management event log
(MEL) to verify that the drive loops are in optimal state. If the DS4000
storage subsystem controller firmware is version 06.10.xx.xx or higher,
use the drive channel diagnostics to determine if the drive loop is
optimal.

Investigate and resolve any errors that reported in the DS4000 Storage
Subsystem MEL.

Save and store the storage subsystem profile of the DS4000 Storage
Subsystem.

It is necessary to purchase the fibre channel/SATA intermix premium
feature option and follow the associated instructions to activate the fibre
channel/SATA premium feature.
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Important:

Do not store DS4000 Storage Subsystem profiles in the same location as the
logical drives defined on your DS4000 Storage Subsystem. Should you do so, and
a RAID array failure occurs during subsequent migration, the data will be lost.

If you are migrating drives from another DS4000 Storage Subsystem, you must also

perform the preceding stepsthrough on the DS4000

Storage Subsystem from which you intend to migrate hard drives. You must also

perform the following steps to flush server-cached 1/O to disks.

___Step 1. Stop all programs, services or processes in the host servers that
access the logical drives defined in the migrated hard drives.

___Step 2. Verify that there are no programs, services, or processes running in the
background that might write data to the logical drives. (For example,
Microsoft® MSCS service periodically writes to the “Quorum” disk.)

___Step 3. Unmount the file systems to flush 1/O from the server cache to disk.

Notes:

a. In a Microsoft Windows® environment, it is also necessary for you to
remove the drive letter or the mount points of the mapped LUNs
instead of unmounting the file systems.

b. Consult documentation associated with your particular operating
system for detailed information regarding the unmount procedure.

After you meet prerequisites described in this section, proceed to any of the
following sections to address your particular drive migration requirements.

+ |[Chapter 3, “Adding one or more new hard drives,” on page 45|

+ |Chapter 5, “Adding expansion units containing new hard drives,” on page 59|
+ [Chapter 4, “Migrating one or more hard drives,” on page 51

+ |Chapter 6, “Migrating expansion units containing hard drives,” on page 77|

+ [Chapter 7, “Upgrading a storage subsystem in a functioning configuration,” on|

page 93|

Verifying controller, NVSRAM, and ESM firmware file levels

The controller firmware and NVSRAM of the DS4000 Storage Subsystem to which
you will migrate hard drives, and the ESM firmware in the DS4000 storage
expansion enclosures must be at the levels indicated in [Table 22 on page 37|to
ensure firmware compatibility between the migrating and original hardware.
Additionally, DS4000 Storage Manager version 8.3 or higher client software, in
conjunction with the controller firmware level 5.30.xx.xx or higher, allows you to
upgrade the ESM firmware while the storage subsystem receives I/O from the host
server.

Note: Always check the readme document included with the DS4000 Storage
Subsystem controller firmware package for any "no 1/0s” requirement during
the controller firmware download. Certain controller firmware upgrade
scenarios may require that you first quiesce host 1/Os.

Tip: Even though you can upgrade the DS4000 Storage Subsystem and ESM
firmware while it processes 1/O from the host server, schedule upgrades to occur
during time periods of low 1/0O between the DS4000 Storage Subsystems and host
servers.
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able 22| lists IBM DS4000 machine types and model numbers, as well as their

current firmware (AppWare or BootWare) and NVSRAM versions.

Table 22. Compatible controller firmware and NVSRAM version by machine type and model

number
Firmware version
Product Machine | Model |(AppWare /
name/model type number | BootWare) NVSRAM version
IBM TotalStorage 1724 1sC 05.42.18.00 N1724F10LR842V01
DS4100 Storage
Subsystem (Single
Controller model)
IBM TotalStorage 1724 100 06.12.03.xx N1724F100R912V05
DS4100 Storage
Subsystem
IBM TotalStorage 3542 1RU 05.30.23.00 N3542-1RUR830V09
FAStT200 Fibre 1RX
Channel Storage
Subsystem
IBM TotalStorage 2RU 05.30.23.00 N3542-2RUR830V12
FAStT200 HA Fibre 2RX
Channel Storage
Subsystem
IBM TotalStorage 3552 1RU 05.30.23.00 N3552F500R830V05
FAStT500 Fibre 1RX (Appware)
Channel Storage 05.30.03.00
Subsystem (Bootware)
IBM TotalStorage 1722 60X 06.12.03.xx N1722F600R834V01
DS4300 Fibre 60U
Channel Storage
Subsystem
IBM TotalStorage 06.12.03.xx N1722F600R910V03
DS4300 Fibre
Channel Storage
Subsystem (with
Turbo option)
IBM TotalStorage 6LU 05.34.08.00 N1722F60LR834V04
DS4300 Fibre 6LX
Channel Storage
Subsystem (Single
Controller model)
IBM TotalStorage 1742 1RU 06.12.03.00 N1742F700R912V05
DS4400 Fibre 1RX (Appware)
Channel Storage 06.10.04.00
Subsystem (Bootware)
IBM TotalStorage 1742 90X 06.12.03.00 N1742F900R912V06
DS4500 Fibre 90U (Appware)
Channel Storage 06.10.04.00
Subsystem (Bootware)
IBM TotalStorage 1815 82x 06.14.1x.xx N1815D480R914V05
DS4800 Fibre 84x

Channel Storage
Subsystem
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Note: Visit the following Web site either to verify software version levels or to
identify possible interim updates to firmware and NVSRAM file versions
described in[Table 22 on page 37}

www-1.ibm.com/servers/storage/support/disk/|

Update the DS4000 controller firmware and NVSRAM to the levels indicated in

[Table 22 on page 37| (or higher) before you upgrade the ESM firmware on the

storage expansion enclosures to versions indicated in[Table 23

able 23| lists IBM DS4000 storage expansion enclosure models by name, machine
type, model number, and current ESM firmware version.

Table 23. Compatible expansion unit ESM firmware version by machine type and model

number
DS4000 Storage Expansion Unit Machine Model ESM firmware
product name/model type number version
IBM TotalStorage DS4000 EXP100 1710 10U 9554
IBM TotalStorage DS4000 EXP500 3560 1RU 9166
1RX
IBM TotalStorage DS4000 EXP700 1740 1RU 9327
1RX
IBM TotalStorage DS4000 EXP710 1740 710 9629

Perform the following steps to upgrade ESM firmware for a down-level controller:

___ Step 1.

__ Step 2.

__ Step 3.

Upgrade the DS4000 Storage Manager software to the latest version.
That is DS4000 Storage Manager version 9.1x. For additional
information, see the IBM TotalStorage DS4000 Storage Manager
installation and support guide for the appropriate server operating
system environment at:

www-1.ibm.com/servers/storage/support/disk/|

Note: To ensure the highest level of software compatibility, update the
host server's multi-path software (Redundant Disk Array
Controller [RDAC], IBMSAN.CDM, or Linux® failover adapter
driver) to the level that is either supported by or released with
the controller firmware that you intend to download. See the
following Web site for current details on software compatibility:

www-1.ibm.com/support/docview.wss?uid=psg1MIGR-50176|

Upgrade the controller firmware and NVSRAM. See [Table 22 on page]
and the web site listed earlier in conjunction with sterm

Note: See the readme file in the DS4000 Storage Manager controller
firmware package associated with the appropriate host operating
system environment for a support statement about the
concurrent controller firmware download (that is, downloading
code to the DS4000 Storage Subsystem while it is processing
I/O from the host server).

Upgrade the storage expansion enclosure ESM firmware. With DS4000
Storage Manager version 8.3 or higher and controller firmware version
05.3x.xx.xx or higher, you can update the ESM firmware while the
DS4000 Storage Subsystem is processing /O from the host server if
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the ESM firmware download is performed to only one storage
expansion enclosure at a time. If you select multiple entries in the ESM
firmware download window for ESM firmware download, you must
quiesce 1/0Os from the host servers before starting the ESM firmware
download process.

Important:

Even though the DS4000 Storage Subsystem supports controller and
ESM firmware upgrade while the DS4000 Storage Subsystem
processes I/O from the host server, schedule controller and ESM
firmware upgrades to occur during time periods of low I/O between the
DS4000 Storage Subsystems and host servers.

Upgrading drive firmware levels

Attention: 1 Gbps fibre channel drives will not operate correctly in a 2 Gbps fibre
channel drive loop. Always make certain that a fibre channel drive can operate at
the fibre channel speed of the drive loop involved before inserting it into the drive
slots in a DS4000 Storage Subsystem configuration. In needed, contact IBM
support to ensure the compatibility of your drives before migrating them from one
DS4000 configuration to another.

Before you begin migration, upgrade the drive firmware to the latest level. Do not
move or migrate fibre channel drives from a 1 Gbps fibre channel environment to a
2 Gbps fibre channel environment unless you have installed the latest firmware
documented to enable their operation in a 2 Gbps fibre channel environment.

Downloading drive firmware

— Important:
The following procedures assume you using controller firmware at version
6.10.xx.xx or later. If you are using an earlier version refer to the following IBM
web site for the appropriate firmware version documentation:

www.ibm.com/servers/storage/support/disk/|

This section provides instructions for downloading DS4000 drive firmware. See the
online help for additional information.

Important:

1. IBM supports firmware download with I/O, sometimes referred to as "concurrent
firmware download”. This feature is not supported for drive firmware.

2. Before starting the drive firmware download process:

» Stop all I/0 activity before downloading drive firmware to a DS4000 Storage
Server.

* Unmount the file systems on all logical drives accessing the drives that you
select for firmware upgrade.

« Complete a full backup of all data residing on the drives that you select for
firmware upgrade.

Downloading Storage Manager version 9.1x drive firmware
To download drive firmware for DS4000 Storage Manager version 9.1x, perform the
following steps:

1. From the Enterprise Management window, select a storage subsystem.
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10.

11.

12.

13.

14.

On the Enterprise Management window’s menu bar, click Tools » Manage
Device. The Subsystem Management window opens.

On the Subsystem Management window’s menu bar, click Advanced »
Maintenance » Download » Drive Firmware/Mode pages .... The Download
Drive Firmware wizard window opens to the Introduction page. Read the
instructions displayed and click Next.

Note: Storage Manager version 9.1x offers you the option to download and
update up to four different firmware file types simultaneously. Previous
Storage Manager versions did not offer this capability.

Click Browse to locate the server directory that contains the firmware that you
plan to download.

Select the firmware file that you plan to download and click OK. The file
appears listed in the "Selected Packages” window pane.

Select the firmware file for any additional drive types that you intend to
download and click OK. Additional files appear listed in the "Selected
Packages” window pane. A maximum total of four drive types are possible.

Click Browse to repeat step|§| until you have selected each firmware file that
you plan to download.

When you have finished specifying the firmware packages for download, select
Next.

The Select Drive window opens, containing two tabs, a Compatible Drives tab
and an Incompatible Drives tab. The Compatible Drives tab contains a list
of the drives compatible to the firmware package types that you selected. From
that list, select the drives to which you plan to download the drive firmware that
you selected in steps |§| and

Note: The firmware that you propose to download should be listed on the
Compatible Drives tab. If your particular drives’ product ID matches
the firmware type, however, and it is not listed as compatible on the tab,
contact your IBM technical support representative for additional
instructions.

Select the Compatible Drives tab.

Press and hold the Ctrl key while using your mouse to select multiple drives
individually, or press and hold the shift key while using your mouse to select
multiple drives listed in series. The compatible firmware that you selected in
steps |5/ and |§| will download to the drives that you select.

Click Finish to initiate download of the drive firmware to each compatible drive
that you selected in step@

The Download Drive Firmware warning opens and prompts: "Do you want to
continue?” Type yes and click OK to start the drive firmware download.

The Download Progress window opens. Do not intervene until the download
process completes.

Every drive scheduled for firmware download will be designated as in
progress until successful or failed.

Note: Complete the following two steps if you receive a failure.
a. Click the Save as button to save the error log.

b. On the Subsystem Management window’s menu bar, click
Advanced »Trouble Shooting » Open Event Log and complete
the following tasks necessary to save the storage subsystem event
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log before contacting your IBM Service Representative and
proceeding to step

1) Click the Select all button.
2) Click Save the Storage Subsystem Event Log.

15. When the Close button appears active, the drive firmware download process is
complete.

16. Click Close to exit the Download Progress window.

17. Use either of the following procedures to determine or verify what level of drive
firmware resides on a particular drive:

* Right-click on that drive in the Logical/Physical View in the Subsystem
Management window and click Properties. The associated drive firmware
version will be listed in the drive properties table.

* Right-click on Storage Subsystem » View Profile in the Logical/Physical
View of the Subsystem Management window.

Downloading Storage Manager version 8.x drive firmware
To download drive firmware for DS4000 Storage Manager version 8.x, perform the
following steps:

1. From the Enterprise Management window, select a storage subsystem.

2. Click Tools » Manage Device. The Subsystem Management window opens.

3. Click Advanced » Download » Drive Firmware. The Download Drive
Firmware window opens. It presents a list of all installed drives.

4. From the list of all installed drives, select the drive to which you plan to
download drive firmware.

Press and hold the Ctrl key while using your mouse to select multiple drives
singly, or press and hold the shift key while selecting multiple drives in series
by using your mouse pointer.

5. Click Browse to identify the directory that contains the drive firmware that you
intend to download.

6. Select the file containing the drive firmware that you intend to download.

7. Select Start. The Confirm Download window appears.

8. Type yes when the Confirm Download window prompts: Are you sure you
want to continue?

9. The download begins and the Status window indicates progress. Do not
intervene until the download process completes.

10. When the Cancel button appears active, the download process is complete.
Press Cancel to close the Status window.

11. To determine or verify the level of drive firmware residing on a particular drive,
click View » Subsystem Profile in the Logical/Physical View of the Subsystem
Management window.

Bringing storage subsystems and drive loops into optimal state

Note: For additional information on how to make this determination, see the
DS4000 Problem Determination Guide associated with your particular
DS4000 hardware model.

After you have updated or verified that a DS4000 Storage Subsystem is using the
latest firmware and NVSRAM:
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__ Step 1.

___ Step 2.

___ Step 3.

__ Step 4.

___ Step 5.

Bring the DS4000 Storage Subsystem to its optimal state before
reconfiguring it with new hardware.

Use the DS4000 Storage Manager client program to display the status
of the DS4000 Storage Subsystem and to correct any problems that
might cause the DS4000 Storage Subsystem to enter its Needs
Attention state.

Verify that all indicator lights on the storage subsystem are in their
optimal state.

In addition, use the Read_Link_Status function of the DS4000 Storage
Manager client program and the DS4000 Storage Subsystem MEL to
verify that all components in the drive loop are in their optimal states
(that is, there are no drive loop component errors in the event log and
no errors in the Read Link Status window.) If you are using controller
firmware 06.10.xx.xx, use the drive channel diagnostics to determine if
the drive loop is optimal. See the DS4000 Storage Manager Client
program Subsystem Management window Online help for more
information on the RLS and drive channel diagnostics if they are
supported by the installed version of your controller firmware.

Drive channel diagnostics are only available if you are using controller
firmware version 06.10.XX.XX.

If the arrays are in degraded state due to a failed drive, correct the
problem before migration.

If necessary, contact the IBM Help Center in your geography for assistance with
event log interpretation.

It is necessary for certain tasks to complete before proceeding to add drives or
enclosures. Before you add drives or enclosures, verify that the storage subsystem
involved is not performing any of the following tasks.

» Dynamic logical drive capacity expansion (dynamic volume expansion [DVE] or
dynamic capacity expansion [DCE])

» Logical drive segment size modification

* Array RAID-level modification

» User-initiated array redundancy checking (menu option Array » Check
Redundancy in the Subsystem Management window)

* Remote mirror logical drive synchronization
+ FlashCopy® or VolumeCopy logical drive creation

» Logical drive reconstruction or copyback. This action is sometimes referred to as
logical drive sparing.

Saving the storage subsystem profile

Use the DS4000 Storage Manager client program to save a DS4000 Storage
Subsystem profile. Such a profile is necessary to restore a storage subsystem
configuration in the event of a catastrophic failure. Migration from one DS4000
Storage Subsystem configuration to another will require that you save both DS4000
Storage Subsystem configuration profiles involved. For details on this procedure,
see one of the following:

» DS4000 Storage Manager client program Client Subsystem Management window
online help

* |IBM TotalStorage DS4000 Storage Manager installation and support guide
associated with your particular operating system environment located at:

www-1.ibm.com/servers/storage/support/disk/|
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» Saving a module profile report and state capture information to help prevent data
loss located at:

www-3.ibm.com/pc/support/site.wss/document.do?Indocid=MIGR-4VVPEH
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Important:

Do not store DS4000 Storage Subsystem profiles in the same location as the
logical drives defined on your DS4000 Storage Subsystem. Should you do so, and
a RAID array failure occurs during subsequent migration, the data will be lost.

Handling static-sensitive devices

Attention: Static electricity can damage electronic devices and your system. To
avoid damage, keep static-sensitive devices in their static-protective packages until
you are ready to install them.

To reduce the possibility of electrostatic discharge (ESD), observe the following
precautions:

» Limit your movement. Movement can cause static electricity to build up around
you.

» Handle the device carefully, holding it by its edges or its frame.

* Do not touch solder joints, pins, or exposed printed circuitry.

* Do not leave the device where others can handle and possibly damage the
device.

* While the device is still in its static-protective package, touch it to an unpainted
metal part of the system unit for at least two seconds. This drains static electricity
from the package and from your body.

* Remove the device from its package and install it directly into your system unit
without setting it down. If it is necessary to set the device down, place it in its
static-protective package. Do not place the device on your system unit cover or
on a metal table. Take additional care when handling devices during cold weather
because heating reduces indoor humidity and increases static electricity.
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Chapter 3. Adding one or more new hard drives

While adding a hard drive to either a controller or a drive expansion enclosure,
observe these important rules:

Observe proper electrostatic discharge (ESD) procedures when handling
electronic equipment. See ['‘Handling static-sensitive devices” on page 44| for
additional information.

Never alter the physical configuration of a DS4000 Storage Subsystem while it is
powered off unless you are instructed to do so as part of a DS4000 configuration
procedure. Specifically, never attach storage components to, or remove storage
components from, a configured DS4000 Storage Subsystem while it is powered
off.

Any hard drive, whether new or old, might contain configuration data. Unless you
intend to migrate a drive from another DS4000 Storage Subsystem (retaining its
configuration data), always use the following procedure to add one or more hard
drives to a functioning DS4000 Storage Subsystem configuration.

The following DS4000 Storage Subsystem devices support only 2 Gbps fibre
channel hard drives:

— DS4000 EXP700 storage expansion units
— DS4000 EXP710 storage expansion units
— DS4300 storage servers

1 Gbps fibre channel drives will not work properly when you insert them into the
drive slots of the aforementioned DS4000 storage devices.

Attention: Always make certain that a fibre channel drive can operate at the
fibre channel speed of the drive loop involved before inserting it into the drive
slots in a DS4000 Storage Subsystem configuration. In needed, contact IBM
support to ensure the compatibility of your drives before migrating them from one
DS4000 configuration to another.

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine
its ID or Model Number. Hard drives with ID or Model Number values that end
with “04FC” or “03FC” are 1 Gbps fibre channel drives. For example,
“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that
appear on several 1 Gbps fibre channel hard drives. 1 Ghps fibre channel drives
can also be mounted in a tray with the front bezel that is about .75" wider than
the 2 Gbps drive tray bezel.

You can also obtain the drive product model and ID through the DS4000 Storage
Subsystem profile. For information on how to do so, see [‘Determining the]
[product ID and model of a drive” on page 32|

Do not mix SATA and fibre channel drives or enclosures together in the same
drive loop behind a DS4000 storage subsystem unless the FC/SATA intermix
premium feature is purchased and the DS4000 Storage Subsystem is in the
storage subsystem list that support FC/SATA intermix feature.

Do not install SATA drives in fibre channel drive expansion enclosures.
Do not install fibre channel drives in SATA drive expansion enclosures.

The following procedure outlines the steps necessary to add one or more new hard
drives to empty drive slots in either DS4100, FAStT200, or DS4300 controllers or in
EXP100, EXP500, EXP700, or EXP710 storage expansion enclosures. If you plan
to add a used drive, ensure that there is no configuration data on the drive that you
need to preserve. Add drives to a DS4000 Storage Subsystem only while it is
powered on and in optimal state. See the DS4000 Problem Determination Guide
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associated with your particular DS4000 hardware model or [‘Bringing storage]

[subsystems and drive loops into optimal state” on page 41 for additional information

on how to make this determination.

Activity 1: Disabling the drive migration settings

Important: Unless you have already done so, please review the information in
Chapter 1 and perform the prerequisites described in Chapter 2 before performing
the activities described in this chapter.

Before you add drives to the subsystem, perform this activity to remove any
configuration data that they might contain.

__ Step 1.
__ Step 2.

__ Step 3.
___ Step 4.

__ Step 5.
___ Step 6.

Open the Storage Manager client program’s Enterprise Management
window.

Right-click on the name of the DS4000 Storage Subsystem to which
you intend to add drives and click Execute Script.

A script editor window opens. Click File » Load Script.

A Load Script file selection window opens. Locate and select the file
named DisableDriveMigration.scr and click OK. The
DisableDriveMigration.scr file is normally located in the SCRIPTS
directory of the IBM DS4000 Storage Manager Installation Compact
Disc (CD). Use this file to reset the DS4000 storage subsystem setting
to ignore configuration data that might reside on newly discovered hard
drives. [Figure 15 on page 49| provides a listing of the
DisableDriveMigration.scr file.

Click Tools » Verify and Execute to run the script.

When the script completes execution, reset both DS4000 controllers to
enable the DS4000 drive migration setting.

If you used the DisableDriveMigration.scr script associated with this
document and described in [Figure 14 on page 48} it is not necessary
for you to perform this step because the last two commands in that
script file automatically reset the controllers.

To reset the controllers, open the Storage Subsystem Management
window and sequentially (one at a time) reset each controller by clicking
Advanced » Reset Controller. Then, follow the instructions in the
Reset Controller window when it opens.

Activity 2: Inserting drives

__ Step 1.
__ Step 2.

Insert drives as pairs (two at a time) into the empty drive slots.
Wait (up to five minutes) until each drive pair has fully spun up and
displayed in the DS4000 Storage Subsystem Management window
before inserting the next drive pair.

Activity 3: Re-enabling the drive migration settings

Perform this activity to re-enable the drive migration settings if you performed

[‘Activity 1: Disabling the drive migration settings’| to disable DS4000 storage

subsystem drive migration settings. If you do not, whenever you might
subsequently, even momentarily remove a drive from the storage subsystem for any
reason, its configuration data will be cleared. When the storage subsystem next
recognizes such a drive, it will display it as unconfigured.
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Attention: In order to prevent data loss, set the DS4000 Storage Subsystem drive
migration to enable after you complete the hard drive addition process.

___ Step 1.
__ Step 2.

__ Step 3.
___ Step 4.

__ Step 5.
__ Step 6.

Open the Storage Manager client program Enterprise Management
window.

Right-click on the name of the DS4000 Storage Subsystem to which
you want to add drives and click Execute Script.

A script editor window opens. Click File » Load Script.

A Load Script file selection window opens. Locate, and select the file
named EnableDriveMigration.scr and click OK. The file
EnableDriveMigration.scr is normally located in the SCRIPTS directory of
the IBM DS4000 Storage Manager Installation CD. Use this file to reset
the DS4000 Storage Subsystem setting in order to check for
configuration data that might reside on newly discovered hard drives.
[Figure 14 on page 48| provides a listing of the EnableDriveMigration.scr
file.

Click Tools » Verify and Execute to run the script.

When the script completes execution, reset both DS4000 controllers to
enable the DS4000 drive migration setting.

If you use the EnableDriveMigration.scr script associated with this
document and described in [Figure 14 on page 48} it is not necessary
for you to perform this step because the last two commands in that
script file automatically reset the controllers.

To reset the controllers, open the Storage Subsystem Management
window and sequentially (one at a time) reset each controller by clicking
Advanced » Reset Controller, and then following the instructions in
the Reset Controller window when it opens.

Result: The newly added drives are ready for you to configure and map
to host servers.

The next two figures list the EnableDriveMigration.scr and DisableDriveMigration.scr

files.
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// Name: Enable Drive Migration

//

// Date: 05-08-2004

// Revision: 1.3

// Comments:

// This script is intended to work with controllers at Firmware 05.30.xx.xx and
// higher only.

//

// This script returned the FAStT to it's default operation of importing
// configuration informration from disks.

//

// This script will reboot both controllers in the FAStT unit. If your
// hosts are configured for multi-path support, this can be done with I1/0
// running to the controllers. If your hosts are not configured for

// redundant access you must schedule downtime before running this

// script.

//

// See the directions at the bottom of this script if you do not have multi
// path software installed and wish to prevent the controller restarts
//

// Show the current state of Drive Migration

show "Showing the current state of Drive Migration (80=0ff, 82=0n)";
show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Setting Drive Migration to Enable

show "Setting Drive Migration to Enable";

set controller[a] nvsrambyte[0x35] = 0x02,0x00;

set controller[b] nvsrambyte[0x35] = 0x02,0x00;

show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Reset Controllers to make changes active. Note:

// To prevent the controllers from restarting, add '//' to the beginning
// of each of the lines below. This will comment out the restart of the
// controllers. Important: The controllers will have to be restarted for the
// changes in this script to take effect.

//

show "Resetting controller A";

reset Controller [a];

show "Resetting controller B";

reset Controller [b];

show "Drive Migration is now enabled.";

Figure 14. EnableDriveMigration.scr file listing
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// Name: Disable Drive Migration

// Date: 05-08-2004

// Revision: 1.3

// Comments:

// This script is intended to work with controllers at Firmware 05.30.xx.xx and
// higher only.

// This script allows the addition of disk drives while the system is running
// and by clearing the configuration of any drives as unused capacity

// regardless of past configuration of these drives.

// Attention: This setting should not be Teft active after the new disks have
// been added to the subsystem. Leaving this setting active could

// cause the configuration for the FAStT to be lost if the FAStT is

// power cycled incorrectly. Please run the EnableDriveMigration.scr

// after all the disks are added.

// This script will reboot both controllers in the FAStT unit. If your

// hosts are configured for multi-path support, this can be done with I1/0
// running to the controllers. If your hosts are not configured for

// redundant access you much schedule downtime before running this

// script.

// Show the current state of Drive Migration

show "Showing the current state of Drive Migration (80=0ff, 82=0n)";
show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Setting Drive Migration to Disable

show "Setting Drive Migration to Disable";

set controller[a] nvsrambyte[0x35] = 0x02,0x02;

set controller[b] nvsrambyte[0x35] = 0x02,0x02;

show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Reset Controllers to make changes active

// To prevent the controllers from restarting, add '//' to the beginning
// of each of the lines below. This will comment out the restart of the
// controllers. Important: The controllers will have to be restarted for
// the changes in this script to take effect.

show "Resetting controller A";

reset Controller [a];

show "Resetting controller B";

reset Controller [b];

//

show "Drive Migration is now disabled. Add the new drives to the subsystem,";
show "then execute the EnableDriveMigrationScript.scr to re-enable drive ";
show "migration.";

Figure 15. DisableDriveMigration.scr file listing

Chapter 3. Adding one or more new hard drives
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Chapter 4. Migrating one or more hard drives

Note: When migrating hard drives from multiple DS4000 storage servers to a

single DS4000 Storage Subsystem, move all of the hard drives from the first
DS4000 Storage Subsystem as an independent "set" to the destination
DS4000 Storage Subsystem. Before moving hard drives as a set from
subsequent DS4000 Storage Subsystem, ensure that all of the hard drives
from the previous set have been successfully transferred to the destination
DS4000 Storage Subsystem. If you do not transfer hard drives as "sets" to
the destination DS4000 Storage Subsystem, the newly relocated
arrays/logical drives that are defined in these drives might not appear in the
Subsystem Management window.

While migrating a hard drive to either a controller or a drive expansion enclosure,
observe these important rules:

© Copyright IBM Corp. 2005

Observe proper ESD procedures when handling electronic equipment. See
[‘Handling static-sensitive devices” on page 44| for additional information.

Never alter the physical configuration of a DS4000 Storage Subsystem while it is
powered off unless you are instructed to do so as part of DS4000 configuration
procedure. Specifically, never attach storage components to or remove storage
components from a configured DS4000 Storage Subsystem while it is powered
off.

Any hard drive, whether new or old, might contain configuration data. Use this
procedure to preserve the configuration and user data in one or more hard drives
that you will migrate to a functioning DS4000 Storage Subsystem configuration.
Do not use this procedure if you are unsure of the quality of the data on the hard
drives.

The following DS4000 Storage Subsystem devices support only 2 Gbps fibre
channel hard drives:

— DS4000 EXP700 storage expansion units
— DS4000 EXP710 storage expansion units
— DS4300 storage servers

1 Gbps fibre channel drives will not work properly when you insert them into the
drive slots of the aforementioned DS4000 storage devices.

Attention: Always make certain that a fibre channel drive can operate at the
fibre channel speed of the drive loop involved before inserting it into the drive
slots in a DS4000 Storage Subsystem configuration. In needed, contact IBM
support to ensure the compatibility of your drives before migrating them from one
DS4000 configuration to another.

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine
its ID or Model Number. Hard drives with ID or Model Number values that end
with “04FC” or “03FC” are 1 Gbps fibre channel drives. For example,
“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that
appear on several 1 Gbps fibre channel hard drives. 1 Ghps fibre channel drives
might also be mounted in a tray with the front bezel that is about .75” wider than
the 2 Gbps drive tray bezel.

You can also obtain the drive product model and ID through the DS4000 Storage
Subsystem profile. For information on how to do so, see [‘Determining the]
[product ID and model of a drive” on page 32|

Do not mix SATA and fibre channel drives or enclosures together in the same
drive loop behind a DS4000 Storage Subsystem unless the FC/SATA intermix
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premium feature is purchased and the DS4000 Storage Subsystem is in the
storage subsystem list that support FC/SATA intermix feature.

* Do not install SATA drives in fibre channel drive expansion enclosures.
* Do not install fibre channel drives in SATA drive expansion enclosures

Activity 1. Preliminary activities

The following procedure describes the steps that you must perform to migrate one
or more drives from a functioning DS4000 Storage Subsystem configuration to
another DS4000 Storage Subsystem configuration. Drives described in the following
steps are those that contain configuration data that you want to preserve. Add such
drives to a DS4000 Storage Subsystem only while it is powered on and in its
optimal state. See the DS4000 Problem Determination Guide associated with your
particular DS4000 hardware model or [‘Bringing storage subsystems and drive loops|
into optimal state” on page 41| for additional information on how to assess the state
of a DS4000 Storage Subsystem.

Important:

Before you attempt to complete the drive migration procedure, review the
information provided in Chapter 1 and perform the steps documented in |Chapter 2,|
[‘Prerequisites to adding capacity and hard drive migration,” on page 35

The procedure for migrating hard drives that contain configuration data that you
want to preserve is as follows:

Before you remove drives from a functioning DS4000 Storage Subsystem, perform
the following steps to ensure that you successfully migrate the drives to the
destination DS4000 Storage Subsystem.

__Step 1. Perform a backup of the logical drives defined in the hard drives that
you plan to migrate.

___Step 2. Stop all programs, services or processes in the host servers that
access the logical drives defined in the migrated hard drives. Ensure
that there are not any running background programs, services or
processes that write data to the logical drives. (For example, the
Microsoft MSCS service periodically writes to the “Quorum” disk.)

___Step 3. Unmount the file systems to flush I/O from the server cache to disks.

Notes:

a. In a Microsoft Windows environment, remove the drive letter or the
mount points of the mapped LUNs instead of unmounting the file
systems.

b. Refer to the documentation associated with your particular
operating system for detailed information regarding the Unmount
procedure.

___Step 4. Verify that the DS4000 Storage Subsystem controller and NVSRAM of
both the source and destination systems are at or above levels
described in [Table 22 on page 37|

___Step 5. Verify that the names of the logical drives that are associated with
hard drives on both the source and destination systems are unique. If
they are not, make the necessary changes.

___Step 6. In addition to array configuration information, any storage partitioning
configuration data that may reside on drives you plan to migrate will
migrate with those drives when installed on another DS4000 Storage
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___Step 7.
___Step 8.

___Step 9.

__ Step 10.

__ Step 11.

__ Step 12.

___ Step 13.

Subsystem. For this reason, take the following precautions to facilitate
the migration process and prevent problems in storage partitioning
configuration data migration.

a. If a DS4000 storage partitioning premium feature has been
enabled both on a drive’s original and destination DS4000 storage
servers, assure that the defined host ports, hosts, and host group
names are unique to each DS4000 Storage Subsystem involved in
the migration.

b. If you must use identical names on both DS4000 Storage
Subsystems, make the names unique before you perform the drive
migration.

If necessary, customize the storage partitioning information on the
DS4000 Storage Subsystem to which you have migrated the drives
after you complete the migration.

Delete any flashcopies of the logical drives defined on the drives that
you plan to migrate.

Remove any remote mirror relationships using the logical drives
defined on the drives that you plan to migrate.

Ensure that the arrays and logical drives are in optimal state before
starting the migration process. See the DS4000 Problem
Determination Guide associated with your particular DS4000 hardware
model or [‘Bringing storage subsystems and drive loops into optimall
[state” on page 41]for additional information on how to make this
determination.

Place the arrays defined in the hard drives that you plan to migrate in
offline state. To do so, right-click on the name of the array in the
Storage Subsystem Management window and click Place » Offline.

If you migrate drive expansion enclosures from a 1 Gbps fibre channel
environment to a 2 Gbps fibre channel environment, verify that the
fibre channel hard drives that you plan to migrate are each capable of
2 Gbps operation and that you have installed the latest firmware
enabling them to work properly in a 2 Gbps fibre channel environment.

Save the DS4000 Storage Subsystem profile of the functioning
DS4000 Storage Subsystem configuration to which the migration will
occur in a location other than that of the logical drives you plan to
migrate.

If you migrate the drives to a single controller DS4000 Storage
Subsystem (for example, DS4300 Storage Subsystem, model 6LU or
6LX), change the logical drive’s preferred owner to Controller A using
the DS4000 Storage Manager client program before taking it offline
and removing it from the DS4000 Storage Subsystem. To set
Controller A as the logical drive preferred owner, right-click the logical
drive entry in the Subsystem Management window and select Change
» Ownership/Preferred Path » Controller A.

Activity 2: Removing the drives to be migrated

While the functioning DS4000 Storage Subsystem is still powered on, remove the
hard drives that you plan to migrate one at a time using the following steps:

__ Step 1.

___ Step 2.

Press on the inside of the bottom of the tray handle to release the blue
latch.

Lift the closed latch to its open position. (The latch is at a 90-degree
angle to the front of the drive when open.)
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___Step 3. Using the handle, slowly pull the drive %-inch out of its drive slot.

___ Step 4. Wait at least 30 seconds to allow the hard drive to spin down before
fully removing it from the drive slot.

__ Step 5. Place the hard drive into an ESD bag or container before moving it to
the new DS4000 Storage Subsystem.

mig00007

Figure 16. Drive CRU assembly
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Attention: Orient drives horizontally and place them in appropriate ESD
bags or containers before relocation. When in transit, use only moving
equipment that prevents shock to the drives. Never stack drives.

Activity 3: Inserting the drives to be migrated

Note: When migrating hard drives from multiple DS4000 Storage Subsystems to a
single DS4000 Storage Subsystem, move all of the hard drives from the first
DS4000 Storage Subsystem as an independent "set" to the destination
DS4000 Storage Subsystem. Before moving hard drives as a set from
subsequent DS4000 Storage Subsystems, ensure that all of the hard drives
from the previous set have been successfully transferred to the destination
DS4000 Storage Subsystem. If you do not transfer hard drives as "sets" to
the destination DS4000 Storage Subsystem, the newly relocated
arrays/logical drives that are defined using these drives might not appear in
the Subsystem Management window.
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___Step 1. While the destination DS4000 Storage Subsystem is powered on, insert
the migrating drives into the empty drive slots in pairs. Wait (up to five
minutes) until the inserted drive pair is fully spun up and displayed in
the DS4000 Storage Subsystem Management window before inserting
the next drive pair.

___ Step 2. As the DS4000 Storage Subsystem recognizes the drives, it reads and
displays the array and logical drive information in the Logical/Physical
view of the DS4000 Storage Subsystem Management window. The
storage subsystem represents arrays in of f1ine state until it recognizes
that you have inserted all of the drives that comprise an array.

___ Step 3. After you migrate all of the drives, manually change the state of the
arrays and logical drives involved from optimal to online state if it has
not changed automatically. To do so, right-click on the array name in the
Storage Subsystem Management window and select Place » Online. If
any of the following conditions persist, contact the IBM Help Center in
your geography for assistance:

* The empty drive slot icon ( e ) displayed for the drive slot into which
you inserted the migrating drive.

* The Failed unconfigured drive icon ( @) or the Failed configured

drive icon ( g ) displayed for the drive slot into which you inserted
the migrating drive.

* Array configuration data on the drives you have added is incomplete.
* You cannot bring the array online.

Attention: Do not initialize a drive that you want to keep (by
right-clicking its icon and selecting Initialize from the pull-down menu) if
it contains configuration or user data. Initializing any drives in a defined
array causes all hard drives known to comprise that array to return to
the Unconfigured Capacity storage pool, deleting their array definitions
from the DS4000 Storage Subsystem configuration. The user data on
such drives is lost.

Result: Once the arrays are online, they are ready to for you to
configure and map to host servers. You might also then recreate
flashcopies of the logical drives.

___ Step 4. Use the DS4000 Storage Manager program to view the storage
partitioning definitions and make any necessary corrections.

___Step 5. The DS4000 Storage Subsystem that the drives are migrated from will
display the logical drives that are defined in these drives as “missing
LUNSs". In order to remove these “missing LUNS” entries, right-click on
each entry and select Delete from the pull-down menu.

Migrating arrays within storage subsystems

Important:

1. Ensure that your controller firmware is at or above the level documented in
[Table 22 on page 37} Do not rearrange more than two or three arrays at a time.

2. Unmount the file systems to flush 1/O from the server cache to disks.

Notes:

a. In a Microsoft Windows environment, remove the drive letter or the mount
points of the mapped LUNSs instead of unmounting the file systems.
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b. Consult documentation associated with your particular operating system for
detailed information regarding the Unmount procedure.

Using the configuration data on existing drives, it is possible to redistribute the
drives that made up an RAID array across a storage subsystem to which you may
be adding expansion enclosures. illustrates a storage array distributed
across three drives on a single storage device before and after reordering. When
you redistribute each drive to a different position in the same storage enclosure as
recommended, the array automatically redistributes accordingly.
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Figure 17. Manner recommended for reordering a defined array using empty slots in one
storage enclosure

illustrates a storage array distributed across three drives on a single
storage device before reordering across two storage devices. When the drives are
redistributed across an additional storage enclosure in the storage subsystem as
recommended, the array automatically redistributes accordingly.
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Figure 18. Manner recommended for reordering a defined array using empty slots in two
storage enclosures

[Figure 19 on page 57|illustrates two arrays distributed across five drives and two
storage enclosures before and after reordering the same drives across other drive
slots in the same two storage enclosures.

Important:

Before you attempt to reinsert any of the drives from either enclosure, place the
array into offline state using the DS4000 Storage Manager client and completely
remove all of the drives of both arrays from both storage enclosures and wait for
the storage manager to mark the arrays/logical drives as missing. After you insert
the drives associated with the first array, wait until that array comes online in a
DS4000 Storage Manager Subsystem Management window before you insert the
drives associated with the second array.
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Figure 19. Reordering multiple defined arrays across previously used slots in two storage
enclosures

Perform the following steps to ensure success when you reorder drives that make
up arrays across different drive slots in the same DS4000 Storage Subsystem
configuration.

1.

Start the DS4000 Storage Manager Client program and open the Subsystem
Management window (for the DS4000 Storage Subsystem which drives you
intend to reorder).

Set the arrays that you plan to move offline.
Mark the drives in the arrays.

Unlatch the drives from their respective slots. Wait at least 2 minutes for each
drive to spin down.

Slowly and carefully remove the drives from their slots.

Assure that all of the drives that made up the arrays are completely removed
from their slots.

Wait for the storage manager to mark the arrays/logical drives as missing in
the Subsystem Management window. See Do not proceed to step
until all of the defined logical drives in the array(s) whose drives are removed
from the DS4000 enclosures display as missing.
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Figure 20. Subsystem Management Logical/Physical View of Missing Logical Drives

8.

Carefully reinsert all of the drives that made up a single array into the empty
slots of the storage enclosure. Do not insert the drives into empty slots that are
part of another array definition whose drives are still inserted in the storage
enclosures. Data on the drives you insert will be replaced with the
reconstructed data from the previously installed RAID array.

The system will recognize the array and bring it online when you finish
inserting all of the drives.
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10. Repeat steps|8 on page 57|and [9 on page 57| for each of the arrays that were
removed from the storage enclosure.

11. Save the storage subsystem profile. See ['Saving the storage subsystem|
[profile” on page 42| for information on performing this activity.

Note: Do not reinsert drives from multiple arrays in random order into the
storage enclosures.
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Chapter 5. Adding expansion units containing new hard
drives

Important:

Observe proper ESD procedures when handling electronic equipment. See
[‘Handling static-sensitive devices” on page 44 for additional information.

While adding storage expansion enclosures containing new hard drives, observe
these important rules:

* Never alter the physical configuration of a DS4000 Storage Subsystem while it is
powered off unless you are instructed to do so as part of DS4000 Storage
Subsystem configuration procedure. Specifically, never attach storage
components to or remove storage components from a configured DS4000
Storage Subsystem while it is powered off.

* Any hard drive, whether new or old, might contain configuration data. Unless you
intend to migrate drives from another DS4000 Storage Subsystem (retaining their
configuration data), always use the following procedure to add one or more
storage expansion enclosures containing one or more hard drives to a
functioning DS4000 Storage Subsystem configuration.

* The following DS4000 Storage Subsystem devices support only 2 Gbps fibre
channel hard drives:

— DS4000 EXP700 storage expansion units
— DS4000 EXP710 storage expansion units
— DS4300 storage servers

* 1 Ghps fibre channel drives will not work properly when you insert them into the
drive slots of the aforementioned DS4000 storage devices.

Attention: Always make certain that a fibre channel drive can operate at the
fibre channel speed of the drive loop involved before inserting it into the drive
slots in a DS4000 Storage Subsystem configuration. In needed, contact your IBM
support representative to ensure the compatibility of your drives before migrating
them from one DS4000 configuration to another.

To identify a 1 Ghps fibre channel drive, locate the product’s label and examine
its ID or Model Number. Hard drives with ID or Model Number values that end
with “04FC” or “O3FC” are 1 Gbps fibre channel drives. For example,
“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that
appear on several 1 Gbps fibre channel hard drives. 1 Ghps fibre channel drives
might also be mounted in a tray with the front bezel that is about .75” wider than
the 2 Gbps drive tray bezel.

You can also obtain the drive product model and ID through the DS4000 Storage
Subsystem profile. For information on how to do so, see [‘Determining the]
[product ID and model of a drive” on page 32|

* Do not mix SATA and fibre channel drives or enclosures together in the same
drive loop unless you have met the fibre channel/SATA intermix requirements.
See ['Intermixing storage expansion enclosures” on page 3|for that information.

* Do not install SATA drives in fibre channel drive expansion enclosures.
* Do not install fibre channel drives in SATA drive expansion enclosures.

The following procedure describes the steps required to add one or more DS4000
storage expansion enclosures containing new drives to a functioning DS4000
Storage Subsystem configuration.
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Activity 1. Preliminary activities

Important:

Before you attempt to complete the drive migration procedure, review the
information provided in Chapter 1 and perform the steps documented in |Chapter 2,|

[‘Prerequisites to adding capacity and hard drive migration,” on page 35,

Add a new DS4000 storage expansion enclosure as follows:

__ Step 1.

___ Step 2.

__ Step 3.

__ Step 4.

Verify that the DS4000 Storage Subsystem is both powered on and in
optimal state. See the DS4000 Problem Determination Guide
associated with your particular DS4000 hardware model or |“Bringing|
[storage subsystems and drive loops into optimal state” on page 41] for
additional information on how to make this determination. You can
perform this process while the DS4000 Storage Subsystem is
processing 1/0O from or to the host server. However, because the drive
loops are interrupted momentarily during the addition process, schedule
additions to occur during time periods of low 1/0O between the DS4000
Storage Subsystem and host servers.

Note: Though there are no restrictions against cabling EXP100 and
EXP700 storage expansion units together, for ease of future
maintenance and possible problem troubleshooting, IBM
recommends that you group or plan your configuration to allow
for grouping of the drive expansion enclosures by type in a
DS4000 Storage Subsystem redundant drive loop, if possible.

Review the readme and the IBM TotalStorage DS4000 Storage

Manager installation and support guide associated with the operating

system environment of the host servers that connect to the DS4000

Storage Subsystem for any additional restrictions or required

preparation tasks specific to your particular operating system

environment. You will find the IBM TotalStorage DS4000 Storage

Manager installation and support guides at:

www-1.ibm.com/servers/storage/support/disk/|

Verify that the DS4000 Storage Subsystem support the DS4000 drive
storage expansion enclosures that you trying to add.

If the new storage expansion enclosure is not the same type as the
existing storage expansion enclosures (some or all) see [‘Intermixing

[storage expansion enclosures” on page 3| for intermix information.

Note: You must group like DS4000 storage expansion enclosure types
in adjacent positions on the Fibre Channel loop when they are
intermixed in a DS4000 Storage Subsystem redundant drive loop
configuration.

Unpack and mount any additional storage expansion enclosures in the
rack using the mounting hardware supplied with each storage
expansion enclosure.

Important::

Do not fully insert hard drives into the enclosures at this time. Keep
them unlatched and no less than %-inch away from their full insertion
points in the drive slots.

Set the enclosure ID of the additional storage expansion enclosures.
Each drive enclosure in the DS4000 Storage Subsystem drive loop
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must have a unique drive enclosure ID. In a EXP500 storage expansion
enclosure, there is an enclosure ID switch mounted on each of two
ESM canisters. Set each ESM canister’s enclosure ID switch in the
EXP500 drive enclosure to the same unique number in the drive loop.
In EXP100, EXP700, and EXP710 storage expansion enclosures, there
is only one enclosure ID switch, which is mounted between the power
supplies. See the appropriate DS4000 storage expansion unit
installation and user’s guide for additional information. [Figure 21]
illustrates the location of enclosure ID switches on the EXP100,
EXP700, EXP710, and EXP500 storage enclosures.
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Figure 21. EXP100, EXP500, EXP700, and EXP710 enclosure ID and speed switches

If the DS4000 Storage Subsystem to which the storage expansion
enclosure will attach is either a FAStT200 or DS4300, the enclosure IDs
of additional storage expansion enclosures must differ from the
FAStT200 or DS4300 Storage Subsystem enclosure IDs, which are
normally set to “0” at the factory.

___Step 5. Verify that the EXP700 Storage Expansion Unit speed switch is set to
the correct drive loop speed.

Note: If a fibre channel enclosure speed switch was originally set to 1
Gbps, do not automatically set it to 2 Gbps unless you are sure
that each fibre channel hard drive that it now contains is capable
of 2 Gbps operation and that you have installed the latest
firmware enabling their operation in a 2 Gbps fibre channel
environment.

Activity 2: Cabling new storage expansion units

To complete addition of DS4000 storage expansion enclosures, cable the new
storage expansion enclosures to the end of the functioning storage expansion
enclosure drive loop to which you are migrating them. Add only one enclosure at a
time to a functioning drive loop if you intend to attach multiple storage expansion
enclosures.

It is possible to connect new storage expansion enclosures at either end of a
functioning storage expansion enclosure drive loop.
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The two options are:

1. The beginning, closest to the controller (at the top, directly attached to controller
A) as described in |Connecting new storage expansion units at the beginning|
[(top) of a drive loop|

2. The end, furthest from the controller (at the bottom, directly attached to
controller B) as described in [Connecting new storage expansion units at the end|
[(bottom) of a drive loop|

Of the two options, IBM recommends only option |2} connection to the end (at the
bottom) of a functioning storage expansion enclosure drive loop, directly attached to
controller B. This is recommended because if the existing DS4000 Storage
Subsystem configuration is not planned for cabling in new storage expansion
enclosures at the top of the drive loop, cluttered or entangle fibre channel drive loop
cabling may hinder drive loop troubleshooting or cause fibre channel cabling errors.
With this in mind, and depending on your requirements, however, follow either of
the instruction sets at[‘Connecting new storage expansion units at the end (bottom)|
of a drive loop”] or [‘Connecting new storage expansion units at the beginning (top)|
of a drive loop” on page 66|

Depending on your DS4000 Storage Subsystem configuration, there might be
unused drive ports that you can connect the new drive expansion enclosures to the
DS4000 Storage Subsystem controllers. Use the appropriate information in your
DS4000 installation, User’s, and Maintenance Guide to attach the drive expansion
enclosures to the DS4000 storage subsystem.

If your DS4000 Storage Subsystem (such as DS4400 or DS4500) has drive
minihubs, do not use more than one port per drive minihub. Always leave one of the
two drive ports empty in each drive minihub. After you connect the drive expansion
enclosures to the DS4000 controller, see [‘Activity 3: Disabling DS4000 Storage]
[Subsystem drive migration settings” on page 70|

Connecting new storage expansion units at the end (bottom) of a drive

loop

The cabling instructions illustrated in [Figure 22 on page 64} [Figure 23 on page 65|
and [Figure 24 on page 66| describe cabling a DS4000 EXP700 Storage Expansion
Enclosure to the end (bottom) of a redundant drive loop of a functioning DS4300
Storage Subsystem (model 60X or 60U). IBM recommends that you add storage
expansion enclosures to an existing drive loops only in this manner. See
[Storage Subsystem drive loop schemes” on page 21

___Step 1. Insert the small form-factor pluggables (SFPs) or gigabit interface
converters (GBICs) into only those ports you intend to use. Do not
leave GBICs or SFPs inserted into port slots without connecting them to
other ports using cables.

___ Step 2. Extend one of the drive loops (that is, drive loop A) in a DS4000
Storage Subsystem redundant drive loop pair by connecting the OUT
port of the last storage expansion enclosure to the IN port of the new
storage expansion enclosure as shown in [Figure 22 on page 64}

Warning: Carefully reconfigure only one drive loop at a time, making
sure that the drive loop that you modify is properly connected and in
optimal state before you attempt to reconfigure another drive loop.
Take this precaution to prevent the arrays from being inadvertently
failed by the DS4000 Storage Subsystem controllers. This happens
when two or more drives in the arrays cannot be reached through either
drive loop in the redundant drive loop pair.
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___ Step 3. Power on the newly added storage expansion enclosure unit.

___ Step 4. Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop A, now extended to the new storage expansion enclosure,
are not lit. Using the DS4000 Storage Manager Client Subsystem
Management window, verify that the new storage expansion enclosure
is added and displayed in the Logical/Physical view of the window.

Correct any errors before proceeding to step [5f For port bypass:

a. Verify that the SFPs and GBICs or fibre cables are in good
condition.

b. Remove and reinsert SFPs, GBICs and fibre cables.

Ensure that the new drive expansion enclosure speed switch is
set to the same speed as the existing drive expansion
enclosures and the DS4000 Storage Subsystem speed setting.

d. Verify that the ESM is good by physically removing and
swapping it with the other ESM in the same drive expansion
enclosure. For enclosure ID conflict, set the drive expansion
enclosure ID switch to values unique from the current settings in
the existing drive expansion enclosures and storage server.

Contact the IBM Help Center in your geography for assistance if the
problems persist.

___Step 5. In the other drive loop (that is, drive loop B) in a DS4000 Storage
Subsystem redundant drive loop pair, remove the connection from the
DS4000 Storage Subsystem drive loop port to the OUT port of the last
storage expansion enclosure and connect it to the OUT port of the new
drive enclosure as shown in [Figure 23 on page 65}

___ Step 6. Wait a few seconds; verify that the port bypass LEDs of the two ports in
the connection between the DS4000 Storage Subsystem drive loop port
and the OUT port of the new drive enclosure are not lit. Using the
DS4000 Storage Manager Client Subsystem Management window,
verify that the new drive enclosure does not indicate the drive
enclosure lost redundancy path error. See the preceding stepEIfor
possible corrective actions, if needed.

Note: The existing storage expansion enclosures will be shown with
drive enclosure lost redundancy path errors until you make
the fibre channel cabling connection described in step .

___Step 7. In drive loop B, cable the new drive enclosure’s IN port to the OUT port
of the last enclosure in the already functioning storage expansion
enclosure drive loop as shown in [Figure 24 on page 66}

__ Step 8. Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop B to which you have added a new connection are not lit.
Using the DS4000 Storage Manager Client Subsystem Management
window, verify that all of the drive enclosures in the DS4000 redundant
drive loop pair to which the new enclosure was added does not report
the drive enclosure lost redundancy path error.
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Connecting new storage expansion units at the beginning (top) of a

drive loop

It is possible to add new storage expansion enclosures to either the beginning (top)
or end (bottom) of a functioning storage expansion enclosure drive loop. The
cabling instructions illustrated in [Figure 25 on page 68 [Figure 26 on page 69} and
[Figure 27 on page 70| describe cabling a DS4000 EXP700 Storage Expansion
Enclosure to the beginning (top) of a redundant drive loop of a functioning DS4300
Storage Subsystem (model 60X or 60U). IBM recommends that you refrain from
adding storage expansion enclosures in this manner, especially if there is
insufficient rack space to allow the methodical, uncluttered, and uniform fibre
channel cabling of such new enclosures. Without proper planning, disadvantages of
adding expansion units in this manner include cable management issues that
contribute to avoidable troubleshooting difficulties. See [Figure 30 on page 74| for the
diagram of a properly planned new expansion enclosure addition at the beginning
(top) of a functioning storage expansion enclosure drive loop.
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The general cabling scheme for DS4000 external drive enclosures is described in
the IBM TotalStorage DS4000 Fibre Channel Cabling Guide available at:

fwww-3.ibm.com/pc/support/site.wss/document.do?Indocid=MIGR-4KELS5|

See also ['DS4000 Storage Subsystem drive loop schemes” on page 21

___Step 1. Insert the small form-factor pluggables (SFPs) or gigabit interface
converters (GBICs) into only those ports you intend to use. Do not
leave GBICs or SFPs inserted into port slots without connecting them to
other ports using cables.

___Step 2. Extend one of the drive loops (that is, drive loop B) in a DS4000
Storage Subsystem redundant drive loop pair by connecting the IN port
of the first (existing) storage expansion enclosure to the OUT port of the
new storage expansion enclosure as shown in [Figure 25 on page 68|

Warning: Carefully reconfigure only one drive loop at a time, making
sure that the drive loop that you modify is properly connected and in
optimal state before you attempt to reconfigure another drive loop.
Take this precaution to prevent the arrays from being inadvertently
failed by the DS4000 Storage Subsystem controllers. This happens
when two or more drives in the arrays cannot be reached through either
drive loop in the redundant drive loop pair.

___Step 3. Power on the newly added storage expansion enclosure unit.

___ Step 4. Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop B, now extended to the new storage expansion enclosure,
are not lit. Using the DS4000 Storage Manager Client Subsystem
Management window, verify that the new storage expansion enclosure
is added and displayed in the Logical/Physical view of the window.

Correct any errors before proceeding to step |5} For port bypass:

a. Verify that the SFPs and GBICs or fibre cables are in good
condition.

b. Remove and reinsert SFPs, GBICs and fibre cables.

c. Ensure that the new drive expansion enclosure speed switch is
set to the same speed as the existing drive expansion
enclosures and the DS4000 Storage Subsystem speed setting.

d. Verify that the ESM is good by physically removing and
swapping it with the other ESM in the same drive expansion
enclosure. For enclosure ID conflict, set the drive expansion
enclosure ID switch to values unique from the current settings in
the existing drive expansion enclosures and storage server.

Contact the IBM Help Center in your geography for assistance if the
problems persist.

__ Step 5. In drive loop A, remove the connection from the DS4000 Storage
Subsystem drive loop port to the IN port of the first storage expansion
enclosure and connect it to the IN port of the new drive enclosure as
shown in [Figure 26 on page 69|

__ Step 6. Wait a few seconds; verify that the port bypass LEDs of the two ports in
the connection between the DS4000 Storage Subsystem drive loop port
and the IN port of the new drive enclosure are not lit. Using the DS4000
Storage Manager Client Subsystem Management window, verify that
the new drive enclosure does not indicate the drive enclosure Tost
redundancy path error. See the preceding stepfor possible corrective
actions, if needed.
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___Step 7. In drive loop A, cable the new drive enclosure’s OUT port to the IN port
of the first enclosure in the already functioning storage expansion
enclosure drive loop as shown in|Figure 27 on page 70}

___Step 8. Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop A to which you have added a new connection are not lit.
Using the DS4000 Storage Manager Client Subsystem Management
window, verify that all of the drive enclosures in the DS4000 redundant
drive loop pair to which the new enclosure was added does not report
the drive enclosure lost redundancy path error.
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Activity 3: Disabling DS4000 Storage Subsystem drive migration

settings

When you have completed cabling the new storage expansion enclosures, disable

DS4000 Storage Subsystem drive migration settings as follows:
___Step 1. Open the Storage Manager Client program Enterprise Management

__ Step 2.

__ Step 3.
___ Step 4.

window.

Right-click on the name of the DS4000 Storage Subsystem to which
you want to add drives, and select Execute Script.

A script editor window opens. Click File » Load Script.
A Load Script file selection window opens. Locate and select the

DisableDriveMigration.scr file and click OK. The file

DisableDriveMigration.scr file is normally in the SCRIPTS directory of the
IBM DS4000 Storage Manager Installation CD. This file is used to reset
the DS4000 Storage Subsystem setting, in order to treat all
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___ Step 5.
__ Step 6.

newly-discovered hard drives as “new” drives, and to ignore any
configuration information that might exist in the new hard drives.
[Figure 15 on page 49| contains the DisableDriveMigration.scr file listing.

Click Tools » Verify and Execute to run the script.

When the script execution completes, reset both DS4000 controllers to
make the disable drive migration settings effective. If you used the
DisableDriveMigration.scr file described in this document in
you do not need to perform this step because the last two
commands in the script file automatically reset the controllers. To reset
the controllers, open the Storage Subsystem Management window and
alternately (one at a time) reset each controller by clicking Advanced »
Reset Controller and following the instructions in the Reset Controller
window when it opens.

Activity 4: Inserting drives and cabling additional storage expansion

units

After you have disabled DS4000 Storage Subsystem drive migration settings, insert
drives and connect additional storage expansion enclosures to complete the
installation process as follows:

__ Step 1.

___ Step 2.

Insert the appropriate drives into empty drive slots in the new enclosure
in pairs (two at a time). Wait (up to 5 minutes) until the inserted drive
pair fully spins up and displays in the DS4000 Storage Subsystem
Management window before inserting the next drive pair.

To connect additional storage expansion enclosures to the functioning
drive loop pair, perform|Activity 1: Preliminary activities| step |3 on page]
60| through step [1 on page 62| and[Activity 2: Cabling new storage]

expansion units| steps as follows:

» If you are connecting additional storage expansion enclosures to the
end (bottom) of a drive loop, complete step [2 on page 62] through
step and step [1] (immediately preceding this step) for
each additional storage expansion enclosure that you intend to add.
(See [Figure 28 on page 72})

» If you are connecting additional storage expansion enclosures to the
beginning (top) of a drive loop, complete step [2 on page 67 through
step and step [1] (immediately preceding this step) for
each additional storage expansion enclosure that you intend to add.
(See [Figure 29 on page 73}) If you are willing to plan your connection
of additional storage expansion enclosures to the beginning (top) of a

drive loop, see [Figure 30 on page 74| for alternate cabling
instructions.

When you have completed adding enclosures, proceed to |thivity 5:|
[Re-enabling drive migration settings| stegl on page 74|to re-enable the
drive migration settings.
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Figure 29. Cabling a second drive enclosure to the beginning of a functioning drive loop
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Activity 5: Re-enabling drive migration settings

If you performed steps[1 on page 70| through[6 on page 71] of [Activity 3: Disabling|
[DS4000 Storage Subsystem drive migration settings|to disable DS4000 Stora
Subsystem drive migration settings, perform the following stepslthrough
to re-enable the drive migration settings. If you should ever momentanly
remove a drive from the DS4000 Storage Subsystem, the storage subsystem clears
its configuration data when it later recognize it. When this happens, the drive
displays as unconfigured.

Attention: In order to prevent data loss, set the DS4000 Storage Subsystem drive
migration setting to enable after you complete the hard drive addition process.

___Step 1. Open the Storage Manager Client program Enterprise Management
window.

___ Step 2. Right-click on the name of the DS4000 Storage Subsystem to which
you want to add drives and click Execute Script.

___ Step 3. A script editor window opens. Click File » Load Script.
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__ Step 4.

__Step 5.
___ Step 6.

___ Step 7.

A Load Script file selection window opens. Locate and select the
EnableDriveMigration.scr file and click OK. The file
EnableDriveMigration.scr file is normally in the SCRIPTS directory of the
IBM DS4000 Storage Manager Installation CD. Use this file to reset the
DS4000 Storage Subsystem setting in order to check for any
configuration data that might exist on the newly discovered hard drives.

Click Tools » Verify and Execute to run the script.

When the script execution completes, reset both DS4000 controllers to
make the setting effective.

If you use the EnableDriveMigration.scr script associated with this
document and described in [Figure 14 on page 48} it is not necessary
for you to perform this step because the last two commands in that
script file automatically reset the controllers. To reset the controllers,
open the Storage Subsystem Management window and alternately (one
at a time) reset each controller by clicking Advanced » Reset
Controller and following the instructions in the Reset Controller window
when it opens.

Verify (and update, if needed) the DS4000 Storage Expansion
Enclosure ESM firmware and drive firmware with the latest version from
the following IBM DS4000 support web site.

www-1.ibom.com/servers/storage/support/disk/|

Result: The newly added drives are now ready for you to configure and map to
host servers.

Note: Listings of the EnableDriveMigration.scr and DisableDriveMigration.scr
files are found in |Figure 14 on page 48| and [Figure 15 on page 49|
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Chapter 6. Migrating expansion units containing hard drives

Note: When migrating hard drives from multiple DS4000 Storage Subsystems to a
single DS4000 Storage Subsystem, move all of the hard drives from the first
DS4000 Storage Subsystem as an independent “set” to the destination
DS4000 Storage Subsystem. Before moving hard drives as a set from
subsequent DS4000 Storage Subsystems, ensure that all of the hard drives
from the previous set have been successfully transferred to the destination
DS4000 Storage Subsystem. If you do not transfer hard drives as “sets” to
the destination DS4000 Storage Subsystem, the newly relocated
arrays/logical drives that are defined in these drives might not appear in the
Subsystem Management window.

While migrating a fibre channel or SATA hard drive to either a controller or a drive
expansion enclosure, observe these important rules:

* Observe proper ESD procedures when handling electronic equipment. See
[‘Handling static-sensitive devices” on page 44| for additional information.

* Never alter the physical configuration of a DS4000 Storage Subsystem while it is
powered off unless you are instructed to do so as part of DS4000 configuration
procedure. Specifically, never attach storage components to or remove storage
components from a configured DS4000 Storage Subsystem while it is powered
off.

» Use this procedure to preserve the configuration and user data in one or more
fibre channel hard drives that you will migrate to a functioning DS4000 Storage
Subsystem configuration. Do not use this procedure if you are unsure of the
quality of the data on the hard drives. Import of incorrect configuration data from
hard drives could cause a DS4000 Storage Subsystem failure.

Use this procedure to migrate one or more DS4000 storage expansion enclosures
containing hard drives which themselves contain configuration data from a
functioning DS4000 Storage Subsystem configuration to another DS4000 Storage
Subsystem configuration.

Attention: Make additions to the DS4000 Storage Subsystem only while it is
powered on and in optimal state. See [‘Bringing storage subsystems and drive]|
[loops into optimal state” on page 41| for additional information on how to make this
determination. You can complete this process while the DS4000 Storage Subsystem
is receiving I/O from the host server. However, because the drive loops are
interrupted momentarily during the addition process, schedule the addition to occur
during time periods of low 1/0 between the DS4000 Storage Subsystems and host
servers.

Review the readme and the IBM TotalStorage DS4000 Storage Manager installation
and support guides associated with the operating system environment of the host
servers that connect to the DS4000 Storage Subsystem for information about any
operating system-specific restrictions in addition to those detailed in this document.
You will also find preliminary tasks that you may be required to complete detailed in
that documentation. IBM TotalStorage DS4000 Storage Manager installation and
support guides are located at the following Web site:

www-1.ibm.com/servers/storage/support/disk/|
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Tip: Before proceeding with the migration procedure, review and perform the steps
outlined in [Chapter 2, “Prerequisites to adding capacity and hard drive migration,’|

|on page 35.|

The procedure for migrating a new DS4000 storage expansion enclosure is as
follows:

Activity 1: Preliminary activities
Important:
Before you attempt to complete the drive migration procedure, review the

information provided in Chapter 1 and perform the steps documented in |Chapter 2,|
[‘Prerequisites to adding capacity and hard drive migration,” on page 35

Before disconnecting any storage expansion enclosures from a DS4000 Storage
Subsystem, to ensure a successful migration of your drives to the DS4000 Storage
Subsystem, perform the following steps:

___Step 1. If the migrated storage expansion enclosure is not the same type as
some or all of the existing storage expansion enclosures, review
[‘Intermixing storage expansion enclosures